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Calyx RIM 7.0

The Release Notes contain information about updated files, new functionality, resolved issues, and any open issues or
workarounds in this release of Calyx RIM 7.0.
The details in these Release Notes supersede all similar details that appear anywhere else in this release of the product
or its other documentation.

Note: Unless stated otherwise, this platform release provides the same functionality and regulatory updates as Calyx RIM
6.2 CHF 6 and Rendering 4.4 CHF 2.

New Brand: Calyx RIM
Calyx RIM was formerly Liquent InSight suite. While the rebranded names of products and components may appear
in the user documentation, the rebranded software user interface will appear in future releases.

SSD Updates
— All IdPs are supported only via federation with Azure AD
— Introduction of SCIM support
— Azure Files/Sync support provides the ability to connect to an on-premises fileshare for seamless transfer of files

(bi-directional) and optimal publishing performance.

Calyx RIM 7.0 introduces support for the following versions of Documentum REST API:
— 7.2
— 16.4
— 20.2

Note: Registrations Forms integration with D2 uses DFS 16.4.

Calyx RIM on Microsoft 365
Calyx RIM 7.0 introduces the Outlook add-in, a separately licensed, subscription-based add-in that integrates with
Microsoft Outlook. This integration enables workflows to help you create submission and reference records in Calyx
RIM directly from Microsoft 365 Outlook.

Analytics with Power BI
Calyx RIM 7.0 provides updated reporting schema supporting datasets for reports using Power BI. The following
OOTB reports and datasets are available with this release:
— Associate Licenses Marketing Status
— RMP Report
— PSMF Annex H Report
— PSUR WMAS Report
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— Worldwide Registrations & Events Reports
— XEVMPD Status

Queries
The following queries are moved from WebFocus Analytics to Querying in Calyx RIM 7.0:
— XEVMPD Submissions - QC Verification and Audit
— XEVMPD Submissions and Acknowledgements

Product Family Enhancements
With Calyx RIM 7.0, Applications can be associated to Products from different Product Families enabling the
tracking of all relevant Products within a single application. This change enables you to capture the process, product,
and submission data under a single application.

Publishing
Performance
improvements

— Increased speed when preparing a publishing ticket for a submission that
has many leafs without content

— Increased speed when preparing a publishing ticket for a submission that
has many Native leafs

Usability and
functional
improvements

— Ability to select multiple volumes and delete them in bulk
— Ability to select which indication section to add a study to via Study Report

wizard
— Support for Extended Range Unicode Characters for publishing requests,

rendering, and text recognition

Publish request screen:
— Default values can be configured via overrides
— Only Default values can be configured via overrides
— Only options applicable to a selected Publish type (Electronic/Paper) are

available for selection
— Selected options are preserved for an assembly and auto-populated next

time publish request is invoked

Functionality and Technology Removed
— Analytics module based on WebFocus.
— SharePoint and Open Text Content Server (Livelink) DMSs support.
— Integration with Documentum via DFC.
— Ability to toggle Kendo/non-Kendo pop-up windows.
— Rendering support for Microsoft Project and Microsoft Visio.
— Rendering from the Documentum queue. Rendering from within Calyx RIM UI is still available.
— Validation against dtd/xsd during publishing.
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— Add User/Group Wizard is removed. (Azure Active Directory is the supported Identity Provider Type for Calyx
RIM. PingOne, Okta, and LDAP IdPs are supported via federation with Azure AD only.)

All IdPs are supported only through federation with Azure AD. The following functionality is removed:
— Direct integration with Okta, PingOne, LDAP
— Change password

Additional Components
These components are available via the Calyx RIM 7.0  platform or as on-premises installations:
— Rendering 5.0 - formerly InSight Rendering
— Viewing 5.5 CHF 6 (5.5.0.6.0015) - formerly InSight for Viewing
— Validator 5.1 CHF 9 (5.1.0.117) - formerly InSight Validator
— Linking plug-in (PDF) 1.8 CHF 1 + (hotfix 1.8.1.4) - formerly SmartLink for PDF
— Linking add-in (Word) 1.8 CHF 1 + (hotfix 1.8.1.4) - formerly SmartLink for Word
— Cumulative View Builder 2.3 (2.3.0.2)
— Authoring and QC plug-in (PDF) 4.2 CHF 1 (4.2.0.42) - formerly SmartDesk for PDF
— Authoring add-in (Word) 3.2 CHF 2 (3.2.022) - formerly SmartDesk for Authoring

Prerequisites
The users and groups who will be using the Calyx RIM 7.0 system should have their accounts created in Azure AD
and provide the User Object IDs for the User migration phase.

Note: For data migration and installation assistance, please contact your Business Development Representative.

API Updates
The Calyx RIM 7.0 includes multiple API updates including the update for Product Family decoupling. Changes
between the InSight 6.2 API and the Calyx RIM 7.0 API are documented in the Calyx RIM 7.0 Administration and
Calyx RIM 7.0 Data Exchange guide. See: Calyx RIM 7.0 Administration > Technical Administration > Calyx RIM API
Documentation and Calyx RIM 7.0 Data Exchange > Data Exchange API > Data Exchange API Document > Calyx RIM
7.0 Data Exchange Change

New in Calyx RIM: Common Functionality

This table shows new features and enhancements of common Calyx RIM functionalities.

Decoupling Product Families and Products from Applications
Product Families and Products are decoupled from Applications. This change provides the ability to create and
maintain an application for products residing in different product families.

Calyx RIM 7.0
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Affected Area Update Benefit

Home page:
— Search menu results
— Find menu results

Navigation:
— Product Family tree
— Countries tree

Based on the relationship updates
between an Application and Product
Family, the menus are updated with
additional columns and fields, some
existing columns and fields are renamed
or removed.

Additional context is
provided when the user
selects Products for the
Application.

Entity Product tabs New columns are added for Family
Code, Family Type, and Family Name.

Updated functionality
provides additional
context when records
are shown.

Wizards — Since the Create Application icon was
removed from the Applications tab on
the Product Family, you can only
create an Application from the Create
Application, Create Submission
(Initial Application) or Global Project
Plan (Create Application) wizards.

— The Product Families filters are
removed from the following wizards:
Create Submission (Initial
Application) and Create Application.

— The Global Project Plan wizard
(Create Application) still enforces
creation of an application within one
Product Family.

The system presents a
variety of efficient
wizard alternatives to
replace creating an
Application under the
Product Family.

Global Project Planning Global Project Plan wizards still support
the Product Family Type filter for all
project types.

Bulk creation and
update of entity records.

Product selection widget — New columns are added for Family
Code, Family Type, and Family Name.

— You can associate any Product to an
Application, regardless of the Product
Family, except for products with the
status of Not Approved or Withdrawn.

This change provides
additional clarity and
flexibility when
associating Products.

Calyx RIM 7.0
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Affected Area Update Benefit

Entities A new rule enforces Product Family
uniqueness from the Family Name.
A new rule is added to enforce
Application uniqueness when you
create, update, or copy an application in
the Calyx RIM system.

— CTA Application type: Application
Code + Study Number

— Non-CTA Application type:
Application Code +
Application Name

With the ability to
associate any Product to
an Application, this
change provides new
uniqueness rules to
identify entities within
the new data model.

Querying To conform to Product Family
decoupling, Queries now include:
— Updated Product Family field names
— Additional Product Family and

Product columns
— Changes to security logic in the

database

Aligned Querying
capabilities with the
updated data model.

Security Administration For a user to have access to an
Application that is associated with
multiple Product Families, that user
should be configured to have access to
at least one Product Family associated
with the Application.
An administrator can now grant user
access to Entity Security > Products for
SPT, ELP, and PRP users.

Azure Active Directory is the supported
Identity Provider Type for Calyx RIM 7.0.
PingOne, Okta, and LDAP IdPs are
supported via federation with Azure AD
only.

Security Administration
functionality is updated
to align with the updated
data model.

Security enhancement The full exception error messages will
not be shown on the screen. For more
information about security errors, check
the server.log file.

This change enhances
security and prevents
potential infringement of
vulnerable data.
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Affected Area Update Benefit

Technical Administration Superuser credentials saved in the
database are now encrypted when:
— A new repository is added (Technical

Administration > Repositories)
— An existing repository is updated

Repository passwords
are now stored securely.

New for Analytics and Reports

Starting with Calyx RIM 7.0, Calyx RIM provides Analytics with Power BI for analytics and reporting.
You can access any data source and unify data from these sources to create interactive, multi-directional dashboards
and reports. See: Power BI website.

Affected Area Update Benefit

I Want To Go To — My Reports
— Favorite Reports

These menu options are no longer
needed and are removed.

Security
Administration

Entity Security section
— Ad hoc Reports
— Reports

These configuration settings are no
longer needed and are removed.

Home Page access
— Reports

This configuration setting is no longer
needed and is removed.

Technical
Administration

Your administrator can create the
link to the Analytics with Power BI
system in the Calyx RIM user
interface for access to the out-of-
the-box reports.

You can access out-of-the-box
Analytics reports and provide a visual
representation of Calyx RIM data.

New in Publishing

This table shows new features and enhancements of publishing functionality.

Calyx RIM 7.0

© Calyx™ 2022. 6 Calyx RIM Release Notes
Calyx.ai New for Analytics and Reports

https://powerbi.microsoft.com/


Affected
Area

Update Benefit

Publish
Request

The Publish Request window now shows options based
on the publishing output channel value (Electronic or
Paper) and the assembly type.

The Publish Request window shows the publishing
output channel options based on the last selected
publishing output value. For example, if you select
Electronic as the publishing output channel value, the
next time you initiate the Publish Request window, the
Electronic output channel options are shown by default.

If you have permission for only one publishing output
channel, only those options that are relevant to that
output channel are available.

In the Publish Request window, the Selected Leaf
Elements option is now selected by default for the
Publish eCTD/Electronic section. It is now possible to
override default values for some of the fields. See: Entity
Fields and Columns Updated: Calyx RIM

The contextual design
minimizes redundant
actions that were required
to be performed previously.
This improves the efficiency
of working with the
application and provides a
better user experience.

DMS
Repository

When different versions or renditions of a document in a
DMS Repository are assigned to assemblies, the
rendition identifier of each document is considered for
displaying specific content, page count, links, and
bookmarks of the assigned document in Calyx RIM.

This change lets the system
maintain a separate set of
extractions for each
rendition of the source
document.

Create Study
Reports

The option Update the sub-folder structure for 5.3.5
Reports of Efficacy and Safety Studies is now included in
the Create Study Reports wizard.

This option lets you add
study reports to specific
Indication folders.

Volumes In an assembly, you can select multiple individual
volumes or select a volume range to delete them
simultaneously. You can use the context menu to delete
the selected volumes in bulk.

The bulk delete
functionality improves the
efficiency of deleting
multiple volumes.

Rendering Extended Range Unicode Characters for publishing
requests, rendering, and text recognition are now
supported.

Calyx RIM can now process
Extended Range Unicode
Characters.

New in XEVMPD

New features and enhancements broadly categorized under XEVMPD are listed in this table.

Calyx RIM 7.0
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Affected
Area

Update Benefit

Reporting The query XEVMPD Submissions -
QC Verification and Audit has been
added under Registration Planning
and Tracking.

The XEVMPD Submissions - QC Verification and
Audit query provides XEVMPD data associated
with a particular Authorised Product for QC
assessment. You can now access this report
directly from within Calyx RIM.

The query XEVMPD Submissions
and Acknowledgements has been
added under Registration Planning
and Tracking.

The XEVMPD Submissions and Acknowledgements
query provides XEVMPD acknowledgement files
information, including 3rd Acknowledgement
Types with the description of the proposed
changes from EMA. You can now access this report
directly from within Calyx RIM.

New in Calyx RIM on Microsoft 365

Calyx RIM 7.0 introduces the Outlook add-in, a separately licensed, subscription-based add-in that integrates with
Microsoft Outlook. This integration enables workflows to help you create submission and reference records in Calyx
RIM directly from Microsoft 365 Outlook.

Affected Area Update Benefit

Calyx RIM Add-in for
Outlook

The Add-in displays the
following:
— Create Submission

Workflow
— Create Submission and

Reference

Enables automation of common business
processes from Outlook to Calyx RIM,
such as creating a sequence and
reference for an application.

Calyx RIM API integration Calyx RIM Outlook add-in is
integrated with, and
consumes information
about overrides via, the
API. For more information,
contact your Business
Development
Representative to consult
with our Client Enablement
team.

Calyx RIM entity meta data is available via
Outlook.
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Affected Area Update Benefit

Overrides Calyx RIM Outlook add-in
integrates with the API to
support overrides applied
to Calyx RIM. Dynamically
rendered forms can contain
fields specified in the
Create Submission
Workflow/Create
Submission and Reference
sections, along with the
overridden required fields.
For more information,
contact your Business
Development
Representative to consult
with our Client Enablement
team.

Supports configuration of overrides to
include extra fields, data types, required/
not-required information, possible values,
and any other applicable data
customization. The dynamic user interface
makes it possible to display specific UI
elements for each customer based on the
configured overrides.

New in Data Exchange

This table shows new features and enhancements of Data Exchange functionality.

Affected Area Update Benefit

Data Exchange The Application Name field size is increased to
VARCHAR2(2000) for the Data Exchange API and
the Calyx RIM API.

The Application Name field
can now accommodate longer
names.
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List of Enhancements: Calyx RIM 7.0

Requested new features and enhancements are included in each release. The items are listed in descending order by
their tracking numbers. Customer case numbers that were recorded when the enhancements were requested are
included in brackets [#####] following the tracking number.

Calyx RIM: Common
Issue CHF/Hotfix Build Description

26698 6.2.0.6.0022 This change enables the selection of the EU National 3.0.3
template for the Great Britain and United Kingdom regulatory
regions when using the Create eCTD Wizard.

26688 6.2.0.6.0022 The Application UUID is now unique within a regulatory region,
instead of being unique within the system.

26682 6.2.0.6.0022 The XEVMPD Wizard is updated to support the EMA XEVMPD
requirement for BREXIT to generate 'XI' as the Authorisation
country code in the EVPRM message for all United Kingdom
registrations.

26681 6.2.0.6.0022 The UUID field is now visible on the application page for the
countries of Great Britain and United Kingdom regions.

26674 6.2.0.6.0022 The United Kingdom country is now available for selection in the
Country field in the Authorized Product Selection tab of the
XEVMPD Submission wizard.

26644 6.2.0.6.0007 It is now possible to withdraw a country from Centralized
Procedure (CP) applications via the Product Details Set. The
withdrawn country is not available to associate with a
subsequent Event (Countries list) created for the same
Application.

26542 6.2.0.5.0055 For EAEU submissions, you can now auto-populate the Output
Folder with metadata values from Solvent and Drug Substance
extensions.

26541 6.2.0.5.0055 You can now include Solvent metadata for EAEU submission
XML.

26519;
[PRB0040530]

6.2.0.5.0055 When diagnosing issues that required a restart, the
data_exchanger.log and server.log files were cleared out after
the restart. The configuration has been modified to prevent the
log files from being cleared out after restart, and messages are
continually added to the existing log files.

List of Enhancements: Calyx RIM 7.0
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Issue CHF/Hotfix Build Description

26512 6.2.0.5.0055 Mass Update Properties was available for Calyx RIM with the
Submission Planning and Tracking (SPT) license, but not with
the Electronic Lifecycle Publishing (ELP) license. Mass Update
Properties functionality is now available for clients with ELP
licenses.

26496;
[INC0025048]

6.2.0.5.0055 When creating a new working assembly using the Create eCTD
wizard in an EU MRP application, the country metadata for the
subsequent countries is copied as the default country metadata
from the first country page except for the Agency name,
Applicant, and Invented Name values even if a new country was
added to the application.

26480;
[INC0023770]

6.2.0.5.0055 In Data Administration > Other Maintenance > Indications/
Intended Use Values, you can use the Mass Update feature to
update a MedDRA Version for multiple Indication/Intended Use
values.

26450;
[CS0092205]

6.2.0.5.0055 Memory usage is optimized when publishing very large
submissions in Calyx RIM.

26437 6.2.0.4.0079 To prevent instances when Calyx RIM could freeze due to an
unstable connection to the Veeva DMS, the following timeout
values have been added to the insight.var file for
connections to the Veeva DMS:
— veeva.api.connect.timeout - The maximum number of

milliseconds the application will wait when attempting to
establish a connection to a Veeva vault.

— veeva.api.read.timeout - The maximum number of
milliseconds the application will wait for a response from
Veeva after a connection has been established to a Veeva
vault.

If these parameter values are not included in the insight.var
file, the respective timeouts will be equal to 30 seconds
(veeva.api.connect.timeout) and 60 seconds
(veeva.api.read.timeout).

26421 6.2.0.4.0079 The updated 510k and PMA assembly templates are included in
this release.

26416 6.2.0.5.0055 The new List of Events with Change Details query enables you to
view events that are associated with change, change details,
and event change details.

List of Enhancements: Calyx RIM 7.0
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Issue CHF/Hotfix Build Description

26387 6.2.0.5.0055 The uniqueness constraint for the EudraCT Number on a
protocol is removed. A study or the clinical trial shared data can
now include a redundant EudraCT Number.

26380 6.2.0.4.0079 Job Request messages include these updates:
— The Job Message text is formatted with line breaks.
— Errors displayed in the Job Message column are presented in

bold text.
— The descriptions of rendering errors are presented in bold

text.
— The Backbone Generator text that starts with ERROR: is

presented in bold text, starting from ERROR: up to the line
break.

26360 6.2.0.4.0079 On the home page, you can choose to show or hide specific
product families from the Product Family navigation tree.

26359 6.2.0.5.0055 You can automate the inactivation of registration attachments
once the corresponding acknowledgment is received via the
XEVMPD Acknowledgement wizard. This option can be
configured through application setup. By default, the option is
disabled. These updates will not appear in the XEVMPD Audit
Report.

26356 6.2.0.5.0055 Extra fields can be updated in bulk on the Event Change Detail
when the Details are associated to the Event via the Project >
Associate Change Detail(s) to Events wizard. For details, please
contact your Business Development Representative to consult
with our Client Enablement team.

26355 6.2.0.4.0079 On the Entity Audit Trail of the Administration tab, you can now
query the following entities:
— Change
— Change Details
— Event Change Details

26354 6.2.0.5.0055 The new System Process Default Flag provides the ability to
assign multiple display statuses to the same Internal System
Status in Data Administration for Application, Event-Change
Detail, Product, Product Detail Set, and Sequence. You can now
see the assigned status after running the wizard or when the
Event is closed manually.

List of Enhancements: Calyx RIM 7.0
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Issue CHF/Hotfix Build Description

26353 6.2.0.4.0079 The Event-Change Detail associations logic is changed. Now, the
logic is based on the individual Event-Change Detail Status. If
there are multiple Change Details associated with one Event and
one of the Change Details has a status of Not Approved or
Withdrawn, it will be available for selection even if the overall
Event is closed as Approved.

26348 6.2.0.4.0079 The number of Veeva API calls has been significantly reduced
for Expand Tree, Assign Binder, and Assign Document actions in
DMS Browse/Search.

26345;
[INC0014459]

6.2.0.4.0079 The performance of the XEVMPD Submission wizard is improved.

26321;
[INC0013546]

6.2.0.5.0055 It is now possible to create a folder or a leaf with an extension
other than Default and extended attributes populated using a
single API call.

26315, 24020,
22557;
[00063191,
00041781,
00053012]

6.2.0.4.0079 When assigning documents from DMS, the leaf name and the
output file name used for documents required revisions. It is
now possible to define customized leaf and document attributes
in the propertyMappings.xml file and use them when
documents are assigned from DMS or File Share.

26314;
[00064910]

6.2.0.4.0079 The ability to create, update, activate, or deactivate Package
Category and Package Type values in Data Administration using
the API is added.

26289;
[INC0012144]

6.2.0.4.0079 Assigning Veeva sections caused the API burst limit to be
exceeded. The number of Veeva API calls for assigning the
Veeva document sections has been significantly reduced.

26265 6.2.0.5.0055 You can identify when any SPOR Maintenance value was created
and by whom. These fields are added:
— Created By
— Created Date

26264 6.2.0.5.0055 You can identify when any Data Administration value was
created/last modified and by whom. These fields are added:
— Last User Updated
— Last Changed Date

26204;
[00064468]

6.2.0.5.0055 The full field value can be viewed in Data Administration when
you create or modify the pick list.

List of Enhancements: Calyx RIM 7.0
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Issue CHF/Hotfix Build Description

26200;
[00064469]

6.2.0.4.0079 The RMS Term Name field now appears as a column in the grid
view for these Data Administration tables:
— ATC Values .
— Compendial Designation/Source Values.
— Concentration Measure Type Values.
— Country Values.
— Denominator Unit Values.
— Numerator Unit Values.
— Dosage/Pharmaceutical Form Values.
— EMA Authorisation Status Values.
— Language Values.
— Legal Basis  Values.
— Medical Device Values.
— Medicinal Product Type Values .
— Procedure Type Values
— Route of Administration Values
— Unit of Measure Prefix Values

26181;
[00063727]

6.2.0.4.0079 Calyx RIM 7.0 enables you to configure a field of comma-
separated values for use as search criteria in DMS Search, for
Documentum only. This configuration can be applied to most of
the text-like document attributes for Documentum. Please
contact your Business Development Representative to consult
with our Client Enablement team.

26158;
[00064073]

6.2.0.4.0079 The Calyx RIM API authentication process is enhanced to
incorporate the LDAP configuration parameters defined in the
insight.var file.

26136;
[00063706]

N/A The List of Events with Change Details report is introduced to
support querying of Change/Change Detail/Event Change Detail
entities with extra fields. Also, the Entity Audit Trail report now
supports querying of Change/Change Detail/Event Change
Detail.

26099;
[00063341]

6.2.0.4.0079 When a new working assembly is created under an application
that includes unlifecycled assemblies, the warning message:
"An unlifecycled working Assembly already exists
for this Application under the following
sequences:" shows the sequence codes for the working
assemblies (with hyperlinks).

List of Enhancements: Calyx RIM 7.0
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Issue CHF/Hotfix Build Description

26081;
[00063116]

6.2.0.4.0079 Calyx RIM 7.0 supports the International Medical Device
Regulators Forum (IMDRF) assembly templates for Health
Canada.

25991, 24795,
23817;
[00060791,
00060643,
00047556,
00039935]

6.2.0.4.0079 When working with Study Tagging Files (STF), generic updates
to extensions and extension attributes had to be made for each
STF individually. It is now possible to update extensions or
extension attributes for STFs in bulk using the Mass Update
Properties feature.

25963
[00060633,
00054727]

7.0.0.0.0100 The Calyx RIM error messages are revised to make them
accurate and easy to follow.
When Calyx RIM displays an error, you can go to the
server.log file to get more details.

25954;
[00060145]

6.2.0.4.0079 In the XEVMPD Submission wizard, the Authorised Product
section error messages have been revised for clarity. See:
XEVMPD Error Messages for Authorised Product in the online
help.

25795;
[00058695]

6.2.0.4.0079 To improve the user experience, the XML Definitions field is
added to the Publish Request window.

24532, 20873;
[00044627,
00037898]

6.2.0.5.0055 New job statuses are introduced for Job Requests:
— Completed with Errors
— Completed with Warnings

24325 6.2.0.5.0055 Calyx RIM now retains the site folders in M5 after importing the
study reports as node extensions.

24222
[00041913]

7.0.0.0.0100 In the Publish Request window, the Selected Leaf Elements
option is now selected by default for the Publish eCTD/
Electronic section.

23946, 23842;
[00039378,
00039725]

6.2.0.4.0079 When modifying the metadata (for example, 2.3.S, 2.3.P, Node
Extension) in an assembly, each node had to be revised and
updated individually. With the Mass Update Properties feature
you can revise and update the metadata revisions in bulk.

23632;
[00038044]

N/A The option Update the sub-folder structure for 5.3.5 Reports of
Efficacy and Safety Studies is now included in the Create Study
Report wizard, to add study reports to specific Indication
folders.

List of Enhancements: Calyx RIM 7.0
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Issue CHF/Hotfix Build Description

23803
[00039687]

6.2.0.5.0055 In an assembly, you can now update the Folder or Leaf
extension value from the Change Type > Extension without
switching to the Default value.

22824;
[00030514,
00043876,
INC0013821]

6.2.0.4.0079 When assigning multiple documents from DMS or a File Share,
leafs were created with the name of the file along with the file
extensions. It is now possible to define leaf and document
attributes without extensions in the propertyMappings.xml
file and use them when documents are assigned from DMS or a
File Share.

22581;
[00026219]

6.2.0.4.0079 When assigning documents, if the leaf title field was blank, the
value for it was not retrieved from a DMS. It is now possible to
define a leaf title value that is taken from a source document in
the propertyMappings.xml file.

20209
[131037FW,
00041581]

7.0.0.0.0100 You can now delete more than one Volume at a time from an
Assembly using the Ctrl or Shift key.

20108;
[129625FW]

7.0.0.0.0100 To improve the user experience, the Publish Request window
now shows only the required fields that are related to the
selected Publishing Output Channel. You can now view/select all
the Publishing Output Channel settings without scrolling.

Rendering
Issue CHF/Hotfix build Description

4977 4.4 CHF 2 A new method of Retrieve request and two new
methods of backbone-generator request are
introduced with this release to support:
— eCTD import of EAEU submissions with PDFs

embedded into XML
— the process of EAEU submissions generation with

PDFs embedded into XML

List of Enhancements: Calyx RIM 7.0
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Resolved Issues: Calyx RIM 7.0

The following issues that were reported to Technical Support have been resolved. Issues are listed in descending order
by their tracking numbers. Customer incident numbers that were recorded when the issues were reported are
included in brackets [#####] following the tracking number.

If an issue was resolved in a previously released certified hotfix (CHF), that CHF build number is included.

Calyx RIM: Common
Issue CHF/Hotfix Build Description

26738;
[INC0056197]

N/A For some of the OOTB and extra fields of the
newTextAreaView and adminTextAreaView types, the
length limit was broken in the UI and after entering, the
system showed only 50 characters in the UI. This issue is
resolved.
Length in the UI is fixed and corrected for the OOTB and
extra fields to show more than 50 characters.

26675 6.2.0.6.0022 Timeline/Event Plans did not work as expected when
adding or removing a country from an existing Event Plan
for MRP, DCP, or CP Procedure Types. Countries already
associated with the existing Timeline/Event Plan were
incorrectly listed in the Countries Available box and were
not available in the Copy Default Lead Times from the
following Country drop-down list. Also, when deleting
countries from an Event Plan, no countries were listed in
the Associated with Plan area. These issues are resolved
to support the EMA XEVMPD requirement for BREXIT.

26673 6.2.0.6.0022 When Northern Ireland (XI) was added to the EU Region in
Data Administration, the XEVMPD wizard did not recognize
it and showed a warning message. This issue is resolved.
The new Northern Ireland country is recognized as an in-
scope country with a country code of XI for an XEVMPD
submission to support the EMA XEVMPD requirement for
BREXIT.

26672 6.2.0.6.0022 Northern Ireland could not be associated as a Registration
Package set entity when added to the Product Detail Set,
so country package set marketing information can be
entered for EU CP Applications. This issue is resolved.
Northern Ireland is associated as a Registration Package
set entity when added to the Product Detail Set to support
the EMA XEVMPD requirement for BREXIT.

Resolved Issues: Calyx RIM 7.0
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Issue CHF/Hotfix Build Description

26620 N/A The security issues related to the following vulnerabilities
are addressed in this release:
— XSS (Cross Site Scripting)
— SSRF (Server Side Request Forgery)
— FPT (Field-programmable Technology)

26619 6.2.0.6.0007 The System Process Default Flag was not available for
Registrations > License Status. A workaround required you
to use only one display status (not multiple) mapped to
one Internal System Status value. This issue is resolved.

26617;
[INC0037885]

6.2.0.4.0079 Some words could not be saved, for example monkey in a
text field, and an error message about invalid characters
appeared. This issue is resolved. Words now can be saved
to any text field in Calyx RIM 7.0 when
enableXssFilter is set to true in the
securityConfiguration.xml file.

26608;
[INC0038408]

6.2.0.5.0055 After migrating to Calyx RIM 6.2 CHF 4, clicking the
Concerned Parties icon resulted in an error. This occurred
if the domain of a user was changed and there was a NULL
value for that user in the Domain column in the SEC.USR
table. This issue is resolved.

26604;
[INC0037291]

7.0.0.0.0100 When a session was timed-out, trying to perform an
activity resulted in the error message You do not have
the appropriate privileges to access the
requested resource. This issue is resolved. Now, if
you try to perform an activity when a user session is
timed-out, the user session will be restored.

26565;
[INC0033560]

6.2.0.5.0055 Calyx RIM did not recognize some users as members of
their assigned Active Directory (AD) groups. This issue is
resolved.

26486;
[INC0024081]

6.2.0.5.0055 If an application had an Active or Not Approved or
Withdrawn status, and the application had a registration
with a status other than Withdrawn, it was not possible to
update an event with Withdrawn status. This issue is
resolved.

Resolved Issues: Calyx RIM 7.0
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Issue CHF/Hotfix Build Description

26477;
[INC0023763]

N/A After Product Family information with its metadata was
updated and then moved from Calyx RIM to D2 LSRD,
subforms on the Properties tab were empty for the
Application in D2 LSRD. When the Application information
was updated separately in Calyx RIM, subforms on the
Properties tab contained the appropriate information. This
issue is resolved. The Propeties tab of D2 LSRD Application
shows correct information when you update a Product
Family or an Application in Calyx RIM.

26476;
[INC0029689]

6.2.0.6.0007 After the Product Family information and metadata were
moved from Calyx RIM to D2 LSRD, making changes to
Product Family Indications/Intended Use in Calyx RIM
resulted in the deletion of the Submission Country value
from D2 LSRD. In Calyx RIM, the application continued to
display the Reviewing Country. This issue is resolved and
the D2 LSRD shows all of the necessary information.

26449 6.2.0.5.0055 An InSight API request to retrieve a list of assemblies for
assembly types other than templates did not work. This
issue is resolved.

26402;
[INC0017878]

6.2.0.5.0055 When an event was closed with a reason using the Specify
Reason for Termination/Withdrawal option, the same
reason was applied to the parent application. This issue is
resolved.

26397, 24517;
[INC0017263,
00044443]

6.2.0.5.0055 When deleting an assembly, there was no indicator to
show the progress of the deletion process. This issue is
resolved. A progress indicator shows that the deletion is in
progress.

26388;
[INC0016307]

6.2.0.4.0079 In the Create Submission wizard Sequence Code field,
despite entering a code of four digits as recommended,
this message showed: If this is an eCTD
submission it is recommended you enter a
four digit sequence code. This issue is resolved.
There are no messages when four digits are entered.

26367 6.2.0.4.0079 Calyx RIM retrieved only the first 999 groups when
authenticating a user in Azure. As a result, users not in one
of the first 999 groups were unable to log on. This issue is
resolved. Calyx RIM now authenticates all users in Azure.

26346;
[INC0014465]

6.2.0.5.0055 Notifications were not sent even when the mail-
service.xml file included a valid SMTP server name and
port number. This issue is resolved.

Resolved Issues: Calyx RIM 7.0
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Issue CHF/Hotfix Build Description

26339;
[INC0014292]

6.2.0.4.0079 Calyx RIM failed to update the following via the API:
— Historical or future dates in the Event Country Status

Schedule
— Projected and actual dates in the Sequence Status

Schedule

These issues are resolved. You can now insert historical or
future dates in the Event Country Status Schedule and the
current actual date in the Sequence Status Schedule.

26323;
[INC0013607]

6.2.0.4.0079 If an assembly was created from another assembly, and
the source assembly was removed from the system,
manually adding an event to the Approved view resulted in
the error: The object you are acting on has
been deleted or modified by another user.
Refresh your object to view the current
information. In the Update Status wizard, trying to add
an event to the Approved view caused Calyx RIM to freeze
and the same error to be registered in the log file. These
issues are resolved.

26316;
[INC0012933]

6.2.0.4.0079 Starting from Calyx RIM 6.1 CHF 4, the migration to 6.2
and CHFs failed with an ORA error in logs for some
customers. This issue is resolved by removing the select
* from dv_user_workflow_secure query from the
migration package.

26307;
[CS0027071]

6.2.0.4.0079 When Calyx RIM was configured to use Single Sign-On via
Microsoft Azure, a user disassociated from an Azure group
added to Calyx RIM could not be re-associated back to
that group. This issue is resolved.

Resolved Issues: Calyx RIM 7.0
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Issue CHF/Hotfix Build Description

26287;
[00012133]

6.2.0.4.0079 The New menu on the Calyx RIM home page displayed the
following options only when access was enabled to more
than one of the options in Security Administration. When
access was enabled to only one of these options, that
option failed to appear under the New menu:
— System Alert
— Publishing Settings Library Template
— Change
— Registration Attachment

This issue is resolved. Now, the New menu shows the
option for which the access is enabled in Security
Administration.

26278 6.2.0.4.0079 When e-signature was enabled for Azure AD users, the
system accepted any user credentials for e-signature
instead of the logged-in user credentials. As a result,
anyone (including Read-only users) could sign in and save
changes. This issue is resolved. Now, only logged-in users
can sign in and save the changes.

26210, 25081;
[00064119,
00064088,
00063968,
00050671]

6.2.0.4.0079 Veeva users configured to use Single Sign-On (SSO) were
unable to access DMS Browse because of authentication
issues. This issue is resolved. Configuration for SSO
authentication is now added to Calyx RIM for Veeva users.
Veeva users can access DMS Browse without
authentication errors.

26122;
[0063208 ]

6.2.0.4.0079 A role was not accessible on the Security Administration
page if the role had all License Modules settings set to
None/Select. This issue is resolved. Now, the No Module
Users role is displayed as expected.

25941;
[00060258]

6.2.0.4.0079 Unauthorized remote users were able to access Red Hat
JBoss EJBInvokerServlet. This issue is resolved by
commenting the JBoss EJBInvokerServlet code block
in the web.xml file. For more information, see
Disabling Unauthorized Users from Accessing
Red Hat JBoss EJBInvokerServlet.

Resolved Issues: Calyx RIM 7.0
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Publishing
Issue CHF/Hotfix Build Description

26670;
[INC0045661]

N/A When an EAEU submission was published, the output file
contained incorrect values in the
<hcsdo:RegistrationFileIndicator> tag. This
issue is resolved.

26625 6.2.0.6.0007 In the EAEU v 1.0 assembly template, some output folder
values were missing and some output file names were
incorrect. This issue is resolved.
Now, output folder values and output file names are
updated as required.

26606;
[INC0038763]

6.2.0.5.0055 The Submission Readiness report took longer to generate
than usual, and sometimes the report failed to generate.
This issue is resolved. Now, the Submission Readiness
report generates successfully in less time.

26597 6.2.0.5.0055 When EAEU submissions were published after performing
a Delete operation on one or more leafs, incorrect leaf
attributes and DocID values were included in the output
XML. This issue is resolved. The output contains correct
values.

26592 6.2.0.5.0055 The Export Published Output process did not support
Cyrillic symbols in filenames when choosing to embed PDF
files into the EAEU XML file. This issue is resolved.

26588 6.2.0.5.0055 The Export Published Output process failed intermittently
when choosing to embed PDF files into the EAEU XML file
when the processed file path included spaces. This issue
is resolved.

26583;
[INC0023438]

6.2.0.5.0055 If a workflow was associated to the assembly root, a
folder, or a document in an initial sequence assembly, and
the Synchronize with the Submitted View option was
applied, the workflow was lost. This issue is resolved.
Associated workflows are kept for each node after the
option is applied.

26582 6.2.0.5.0055 The mediaTypeCode attribute was missing from the
embedded PDF nodes of the EAEU XML output file.
Although this attribute is not required per the schema, the
agency validator requires it. This issue is resolved. The
mediaTypeCode attribute is now included in the EAEU
XML file for embedded PDF nodes.

Resolved Issues: Calyx RIM 7.0
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26556;
[INC0033264]

6.2.0.5.0055 When using the Synchronize with the Submitted View
option, the time to synchronize the documents sometimes
took longer than usual. This issue is resolved.

26537;
[INC0030024,INC003
3088]

6.2.0.5.0055 All leaf Titles should have appeared in XML under the
following conditions:
— If a user published all XML from root assembly.
— If an assembly had two leafs and one leaf is selected,

Title for both leafs had to be published, not for only
one. This condition did not work.

This issue is resolved. If all the XML is published from the
root assembly, or if one of two leafs is selected and
published, the system generates equal results in both
cases.

26533;
[INC0029832]

6.2.0.5.0055 Errors were found when the Publishing Readiness Query
was run for the China eCTD. This issue is resolved.

26530;
[INC0029543]

6.2.0.5.0055 The Document Creation Date showed the current date,
even though no value was specified for that field in the
modify mode. This issue is resolved. Now, Document
Creation Date displays a date only when the field is
populated.

26527, 26226,
25965;
[INC0029460,
00064445]

6.2.0.5.0055 The options For this Element and Document were not
available on the Update Overlay Settings page invoked
from the Document. This issue is resolved.

26502;
[INC0025226]

6.2.0.5.0055 Applying the eCTD Import to an AU-3-0 assembly where
the Sequence Description attribute had a code values
different from those provided by the agency caused the
import to fail. This issue is resolved. Now the import
ignores the mismatches and takes the code value.

26487;
[INC0024292]

6.2.0.5.0055 After importing published GCC submissions, some folders
were renamed or missing. This issue is resolved. Now, the
imported assembly keeps the original structure.

26469;
[INC0023438]

6.2.0.5.0055 If a Workflow was associated to a leaf in an initial
sequence assembly and the Synchronize with the
Submitted View option was applied, the Workflow was
lost. This issue is resolved. Associated Workflows are kept
for each leaf after the option is applied.

Resolved Issues: Calyx RIM 7.0
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26458;
[INC0022479]

6.2.0.5.0055 Publishing failed for the 2.3.S, 2.3.P, and 2.7.3 folders of
ICH Module 2-5 v3.2 when the metadata field contained a
single quote character. This issue is resolved.

26455;
[INC0022252]

6.2.0.5.0055 Variables with spaces in the Variable Name field did not
resolve in the published output. This issue is resolved.

26452;
[INC0015705]

26383;
[INC0015705]

6.2.0.4.0079 In an application containing single or multiple sequences,
using the Create eCTD wizard from the Sequence page
resulted in the Concerned Parties values getting deleted.
This issue is resolved. The information of the Sequence
Concerned Parties is displayed properly.

26444;
[INC0021105]

6.2.0.5.0055 Incorrect Folder/Leaf names were observed in sections
1.08, 1.09, and 1.12 in JP eCTD Module 1 v1.0 assembly
template. This issue is resolved. The JP eCTD Module 1
v1.0 assembly template is updated.

26401;
[INC0017630]

6.2.0.5.0055 When deleting leafs in bulk using Delete (Withdraw)
lifecycle operation in the Working assembly, the assembly
tree refreshed and the deletion symbol (crossed leaf)
appeared only on one of the leafs instead of all of them.
This issue is resolved.

26438;
[INC0020386]

6.2.0.4.0079 The <sequence> value in published .xml output was not
the same as the value defined for Sequence on the
regional or envelope Folder Attributes page. This issue is
resolved.
The value defined under the Folder Attributes page is
displayed in the <sequence> tag for the versions of EU
3.0.1/3.0.3, JO-1.0 and GCC-1.5.

26434;
[INC0020054]

6.2.0.5.0055 In Internet Explorer, when using the Delete (Withdraw)
option on multiple leafs from subfolders of a Working
assembly, the process would run for a long time with no
result. This issue is resolved. The method used to
communicate with the server is changed and now you can
select any number of leafs to withdraw.

26425;
[INC0376737]

6.2.0.5.0055 In a Working assembly with documents assigned from
Documentum, the links created to bookmarks in other
documents using Calyx RIM Linking plug-in (PDF) resolved
to incorrect pages after publishing. This issue is resolved.

Resolved Issues: Calyx RIM 7.0
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26422;
[INC0019310]

6.2.0.4.0079 Links with "Application" applicability were mixing
(appeared where not necessary and disappeared where
necessary) after DMS synchronization if the new minor
version of the same document had been created in
Documentum. This issue is resolved.

26409;
[INC0018167]

6.2.0.4.0079 The search function did not work in the Approved Views of
an assembly. This issue is resolved.

26404;
[INC0018012]

6.2.0.4.0079 When a link was created to a bookmark in a document
from a previous sequence, the link created targeted to the
first page of the document, instead of the bookmark. This
issue is resolved. Now the links target to the correct page.

26395;
[INC0016670]

6.2.0.4.0079 Folders in the approved view were out of order. This issue
is resolved.

26386;
[INC0016091]

6.2.0.4.0079 A first request to create the parexel__c rendition for a
PDF document from Veeva failed. This issue is resolved.
The source document is retrieved instead of the
parexel__c rendition if Standard Rendition is selected
for a Veeva PDF file. For another Rendition Identifier value
and non-PDF documents, the corresponding rendition is
used. Now, in some cases two calls instead of three are
sent to Veeva.

Resolved Issues: Calyx RIM 7.0
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26370;
[INC0015274]

6.2.0.5.0055 The pagination formulas using Reverse and Bates types
did not resolve properly for paper publishing. Example:
$Bates($Reverse($Calculate(${ATP}-${ARP}
+1),"-1"),5).
This issue is resolved. The formula works when an
intermediate variable is used as the first one in
alphabetical order according to Variable Code. Example:
— Variable Name = someTestName, Variable code =

calcRevPage,Variable Value =
$Reverse($Calculate(${ATP}-${ARP}
+1),"-1")

— Variable Name = someTestName , Variable code =
revBates, Variable Value = $Bates($calcRevPage,
5)

To experience better performance, we recommend to
minimize the formulas usage and set up them in
Publishing Settings Library, not in Data Administration.

26361;
[INC0014994]

6.2.0.4.0079 Leaf attributes were missing from a leaf in the Approved
View when that leaf was replaced in a previously lifecycled
sequence. This issue is resolved.

26344;
[INC0014379]

6.2.0.4.0079 On the Add or Edit Page Marker menu, changing the Page
Number to more than 3 characters caused the error
message: Page Number cannot exceed 3
characters. This issue is resolved. Now, it is possible to
enter 5 characters in the Page Number field.

26340;
[INC0014300]

6.2.0.5.0055 After reordering leafs in a Working Assembly using
Reorder Child Leafs option, users observed empty folders
in Publishing and Sequence views. This issue is resolved in
InSight 6.2 CHF 4 as a result of other fixes.

26328;
[INC0014090]

6.2.0.4.0079 When the lifecycle operation on the same leaf across
different sequences was performed and those events
were added to the Approved View, using the Change
Status Wizard resulted in an error. This issue is resolved.

26320;
[CS0042776 ]

6.2.0.4.0079 Users authenticating with Azure AD were unable to access
Veeva using Single Sign-On (SSO) when Veeva was
configured to authenticate using ADFS. This issue is
resolved.

Resolved Issues: Calyx RIM 7.0
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26310, 19440;
[INC0012460]

6.2.0.5.0055 After performing a DMS Synchronization on an assembly
with an assigned document that was versioned, the
document attributes and assembly tree were not
automatically refreshed by Calyx RIM. This issue is
resolved. Now, the icon 'Newer version available' is
displayed without having to manually refresh the
assembly tree.

26300;
[00063883]

6.2.0.4.0079 After an EU MRP assembly with an updated folder
structure different from the template order was lifecycled,
the Sequence view displayed empty folders in the next
Working assembly after Create eCTD wizard was
launched. This issue is resolved. Now, the Sequence view
does not include any empty folders.

26291, 26410;
[INC0012181,
INC0018227]

6.2.0.4.0079 In a working assembly, performing a Replace operation on
a reference leaf failed to load the assembly tree. This
issue is resolved.

26286;
[INC0012051]

6.2.0.4.0079 Retrieving a list of assembly templates via API requests
failed. This issue is resolved. Now, the list of assembly
templates via API requests can be accessed successfully.

26276;
[INC0011104]

6.2.0.5.0055 The assembly templates for CH 1.3 and CH 1.4 contained
errors that caused validation issues. This issue is resolved.

26255;
[00065020]

6.2.0.4.0079 Creating a standalone assembly using the JO 1.0
assembly template and then executing the Create Study
Reports wizard failed with the cannot determine
region based on dtds error. This issue is resolved.
The Create Study Reports wizard now runs successfully,
and you can create a standalone assembly using the JO
1.0 assembly template without error.

Resolved Issues: Calyx RIM 7.0
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26247, 26405;
[00064107,
00016162,
INC0018046]

6.2.0.4.0079 When a document from a Veeva repository was assigned,
the rendition information was recognized incorrectly by
Calyx RIM. This resulted in an unnecessary extract
request. If a TOC had Calyx RIM bookmarks that were
edited, the edit changes did not appear in the generated
TOC. Also, an extraction request was sent with each
rendition, even when the rendition parameters were not
changed. These issues are resolved. When documents are
assigned from a Veeva repository, the rendition
information is recognized correctly and edits appear
correctly in the generated TOC. If rendition parameters
are not changed, no extraction request is sent.

26245;
[00065009]

6.2.0.4.0079 Calyx RIM authentication via API failed when an
application server was configured with multiple domains.
This issue is resolved.

26240;
[00064944]

6.2.0.4.0079 When replacing a leaf in a subsequent sequence
associated with a new event, closing the event and
creating an approved view, both the new leaf and the
replaced leaf were displayed in the approved view. This
issue is resolved. Only the replaced leaf is displayed in the
approved view.

26221;
[00064631]

6.2.0.5.0055 In EU Submissions with MAA in Submission Type and with
the initial value in Submission Unit Type, the users were
able to save the empty INN in EMA Envelope Information.
This issue is resolved. Now, the users are required to
populate it when needed.

26199;
[00064147]

6.2.0.4.0079 After updating a template and running Render Generated
TOCs and Special Sheet Templates, extractions were
generated for each assembly element containing a special
sheet if it pointed to the same template and there were
multiple settings profiles with the same template file. This
issue is resolved. Now, the extraction request is sent for
each special sheet template.

26163;
[00063867]

6.2.0.4.0079 The folder structure of study reports created when
importing an eCTD application was incorrect. This issue is
resolved. The folder structure of study reports is now
created correctly when importing an eCTD application.

Resolved Issues: Calyx RIM 7.0
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26142;
[00063604]

6.2.0.4.0079 When using the Volumize feature on an assembly that
contained a volume with a TOC attached to it, there was
an error. This issue is resolved. Now, using the Volumize
feature on an assembly containing a volume with a TOC
attached to it does not display an error.

26139;
[00063733]

6.2.0.4.0079 Creating a new assembly, or importing using an existing
assembly, took longer than expected. This issue is
resolved. The performance of creating a new assembly, or
importing an assembly using an existing assembly, is
improved.

26137;
[00062685]

6.2.0.4.0079 An invalid reference error occurred when changing the
XML definition file in the publishing settings from U.S.
2.0.1 to U.S 3.3, if more than one application type with the
same us-3-3 Application DTD/Schema and eCTD code
existed. This issue is resolved. Now, no error shows when
changing the XML definition file in the publishing settings
from U.S. 2.0.1 to U.S 3.3.

26120;
[00063566]

6.2.0.4.0079 When an assembly section was selected in the Import
Assembly Wizard, or when an assembly was created from
an existing assembly, the corresponding assembly tree
sections at the bottom half of the page were not
displayed. Also, the full length of the scroll bar was not
displayed, even on a maximized browser window. These
issue are resolved. When an assembly section is selected
in the Import Assembly Wizard. or when creating an
assembly from an existing assembly, the corresponding
assembly tree sections are displayed. The full length of
the scroll bar shows on the browser window.

26057;
[00063029]

6.2.0.4.0079 The Reset TOC Content button was not enabled in
assemblies unless the Standalone Assemblies value for
home page access under Security Administration was set
to Yes. This issue is resolved.

26046;
[00062700]

6.2.0.4.0079 The performance of refreshing the Link Inspector took
several hours. This issue is resolved. The performance has
been improved in sequence assemblies with:
— External links in documents when source and target are

within the same tree
— Internal links in documents
— In-Process links in documents

Resolved Issues: Calyx RIM 7.0
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25979;
[00060743]

6.2.0.4.0079 When the screen resolution was set lower than [X]x1050
format, users were not able to send a publish request
because the OK and Cancel buttons on the Publish
Request and Job Details windows were not visible. This
issue is resolved.

25862 6.2.0.4.0079 In an assembly tree, after running Prepare to Publish,
deleting a leaf containing a source document linked to a
target document resulted in a warning: ORA-02292:
integrity constraint (ODS.R_339) violated -
child record found. This issue is resolved. A leaf is
deleted successfully.

25831 6.2.0.5.0055 When using the API to convert a leaf to reference, it could
not be targeted to a leaf from a Sequence view. This issue
is resolved.

25566;
[00054314]

6.2.0.4.0079 When using the eCTD Import process to import an
assembly containing reference leafs and assigned
documents in the assembly tree, the reference leafs and
the documents were switched in the imported assembly.
This issue is resolved.

25487;
[00055381]

6.2.0.5.0055 The Find and Replace option did not function as expected
in the Publishing view of an assembly and the updated leaf
names were not available in the current sequence in the
Working view. This issue is resolved. Now, in the
Publishing view, the Find and Replace option updates the
nodes as expected in the current sequence in the Working
view.

25263;
[00052834]

6.2.0.5.0055 GCC submissions containing multiple Cover Letters could
not be imported to Calyx RIM. This issue is resolved.

23864;
[00039884,
00054020,
00055522,
INC0016252]

6.2.0.5.0055 Using the Change Submittal Status wizard after changing a
folder extension in a later sequence caused a reference
error. This issue is resolved.
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Issue CHF/Hotfix Build Description

25325;
[00053635,
00055122,
00059463,
00062975,INC00162
53, INC0016254,
INC0017802]

6.2.0.5.0055 GCC sequences failed an eCTD import because of missing
language folders in xlink:href. This issue is resolved.
Now, the eCTD import is completed with no errors in the
Job Requests even if language is missing for some folders.
The system takes the English language as the default one
and the language folder name is the same as in GCC
template.

23864;
[00039884,
00054020,
00055522,
INC0016252]

6.2.0.5.0055 Using the Change Submittal Status wizard after changing a
folder extension in a later sequence caused a reference
error. This issue is resolved.

Registrations
Issue CHF/Hotfix Build Description

26447 6.2.0.4.0079 On the Product Family Attributes page, the following
attributes were incorrectly listed after the Development
Sponsor attribute. This issue was specific to the
Pharmaceutical, Veterinary and Flu Vaccine product family
types. This issue is resolved. Now, these attributes are
listed after the Approved Trade Names attribute.
— Product Family Concerned Parties
— Product Family Keywords
— Product Family Description
— Product Family Comments

26419;
[INC0019054]

6.2.0.4.0079 When a Package Set was associated with a Registration
instead of with a Full Product Presentation (FPP), the
information from the PDS Active Ingredients of the
Package Set was included in the submission XML. This
issue is resolved. Only Active Ingredients from Package
Sets associated with a Full Product Presentation are now
included in the XEVMPD submission XML.

26417;
[INC0018864]

6.2.0.4.0079 An Application was not updated with the Withdrawn status
despite the Registration License Status value being
internally mapped to Withdrawn. This issue is resolved.
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Issue CHF/Hotfix Build Description

26398;
[INC0017367]

6.2.0.4.0079 When using the Copy Registration Wizard, trying to copy a
registration in a multiple country application such as an
MRP or DCP resulted in an error. The error was due to the
constraint on the Medicinal Regulatory Agency field. This
issue is resolved.
After using the Copy Registration Wizard, the field
Medicinal Regulatory Agency becomes blank and the value
must be updated manually.

26227;
[00064595]

6.2.0.4.0079 If the time of the Approved status was set to a time that
was earlier than that of the Submitted status, the status in
the Event attributes page in the Countries tab changed to
Submitted. This issue is resolved. Now, the calculation of
Event Country Statuses is corrected. The current status
shows the latest actual date.

26193;
[00064402]

6.2.0.4.0079 In the Registration Attachment page, selecting a file that
had an extension in upper case (such as .DOC or .PDF)
failed to populate values for the Attachment Name and the
File Name fields. This issue is resolved. Values for
Attachment Name and File Name fields are populated as
expected.

26127;
[00063568]

6.2.0.4.0079 The URL in the e-mail that was sent to concerned users
when an Event-Country Status was changed, failed to
resolve to the expected target. This issue is resolved. Now,
clicking the URL navigates to the event country where the
status was created or updated.

26063;
[00062715]

6.2.0.4.0079 The query for the List of Product Registrations with
Application and Product Detail Properties report failed to
show the results on the screen. This issue is resolved.
Now, the query for the List of Product Registrations with
Application and Product Detail Properties report shows
the results on the screen.

25996;
[00060206]

6.2.0.4.0079 In the Global Project Plan (GPP) wizard, selecting multiple
events that exceeded the query limit resulted in the
disappearance of the Update Project Event Country Status
field, in some cases. This issue is resolved. The SQL query
limit is increased for Event Country Status field in GPP
wizard Update Project Event Country Status flow.
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XEVMPD
Issue CHF/Hotfix Build Description

26336;
[INC0014237]

6.2.0.4.0079 The XEVMPD Submission wizard worked incorrectly for the
Invalidate MA operation type on an Authorised Product
when there was more than one Event and this resulted in
the error: No Active Ingredient was specified.
This issue is resolved. For the Invalidate MA operation
type on an Authorised Product, when there are multiple
Events for the same PDS, the XEVMPD Submission wizard
works correctly.

Workflows
Issue CHF/Hotfix Build Description

26195;
[00064087]

6.2.0.4.0079 When an activity name was longer than 255 characters,
trying to complete that activity resulted in an error. This
issue is resolved. Now, an activity name can contain up to
1000 characters.

25990;
[00060779]

6.2.0.4.0079 When creating an Event-Country Status under a closed
Event that was created via a workflow, there was an error.
This issue is resolved. Now, there will be no error when
creating an Event-Country Status under a closed Event
that is created via a workflow.

Rendering
Issue CHF/Hotfix

Build
Description

4999;
[INC0040253]

4.4.1.1 Inserting a metafile (.emf) conflicted with the Amyuni
printer driver and caused the rendition to fail. This issue is
resolved. It is recommended that you convert any .emf file
to a different format before inserting to prevent rendition
issues.

4998;
[INC0037216]

5.0.0.17 When a large file from Veeva DMS was assigned to an
assembly and published, the publishing process failed with
the System out of memory error. This issue is resolved.
Now, large files from Veeva DMS assigned to an assembly
publish successfully.

4997 4.4.1.1 After rendering Word documents, some links in the
rendered PDFs were sometimes split into multiple link
boxes. This issue is resolved. Now the links are displayed
correctly.
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Issue CHF/Hotfix
Build

Description

4991;
[PRB0040598]

4.4 CHF 2 Some native links could disappear under certain conditions,
such as splitting a document in an assembly into several
page ranges. This issue is resolved. Now the links are
displayed and navigate to the correct locations.

4988 N/A The Business Service Retrieve re-authenticated with Veeva
on each request processed and caused the Veeva API burst
limit to be reached. This issue is resolved. Rendering now
includes a cache that saves login data so that it does not
have to authenticate each time it needs to get a document
or information from Veeva.

4979 4.4.1.4 Publish jobs failed when attempting to publish two
documents assigned from Veeva with Publishing Output
Channel = Paper. This issue is resolved.

4975, 4928, 4895;
[00056617, 00062932,
INC0016169,
INC0021914]

4.4 CHF 2 Print jobs using the Liquent PS Printer option failed due to
memory management issues in the third-party component
responsible for converting PDF to Postscript. This affected
Postscript-based printers only. This issue is resolved.

4958;
[00056740, INC0013561]

4.4 CHF 2 Watch requests failed if the server they belonged to was
down or suspended. This was caused by a problem with the
repository backup algorithm. This issue is resolved. Now a
backup repository will properly execute watches that
belong to a down or suspended repository.

4946;
[00064768]

4.4.0.49 Rendering was not able to communicate back to the
application server on networks that did not allow TLS 1.0
encryption. This issue is resolved.

4945;
[00064279]

N/A Thai and other scripts that depend on combining diacritics
had those diacritics incorrectly placed on printed tabs. This
issue is resolved. Thai text is correctly printed on tabs.

4929;
[00062908]

4.4 CHF 2 Issues with the Auto Text Wrap option for tabs caused
improper line breaks, which required the manual override
of tab text. This issue is resolved by an expanded list of line
break symbols.

4889;
[00055307,00058062,
00060015, 00060371]

N/A The maximum file size that could be retrieved for publish or
render is 2 GB. To publish or render successfully, it was
recommended to divide the files larger than 2 GB to smaller
files and save. This issue is resolved. Now, you can retrieve
files that are larger than 2GB for publish or render.
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Issue CHF/Hotfix
Build

Description

4850; [00052462] 4.4.1.1 Rendering limited the number of sub-jobs to 25 per
workflow and would not start the next workflow until all 25
sub-jobs had completed. This issue is resolved. Now, the
total MaxConcurrent for the Workflow Business Service on
all servers is multiplied by 3 to control the number of jobs
in progress, with 10 as the minimum and 40 as the
maximum. Examples:

Servers Maximum
concurrent

Formula
value

Jobs in
progress

2 servers 3 10 (low limit) 3

2 servers 15 10 (low limit) 10

4 servers 5 12 (4*3) 5

4 servers 15 12 (4*3) 12

20 servers 5 40 (high
limit)

5

20 servers 50 40 (high
limit)

40

4767;
[00056042, 00048240,
00050634, 00055970,
00058496]

4.0.0.96 Rendering Microsoft Word and Excel documents containing
objects that reference external sources is not supported by
the Rendering platform. To prevent such job requests from
failing, this update suppresses errors associated with such
objects and allows rendering of documents containing such
content to complete successfully, although rendition
fidelity is not assured.

4639;
[00041423]

4.4 CHF 2 Large jobs sometimes failed and showed the error
message, "Not enough storage is available to complete this
operation." Tickets are now optimized to reduce their size.

4592 4.4.0.51 Publishes with many small distribute requests (as in NeeS
or leaf-only publish submissions) failed intermittently with
the error: "Unable to distribute folder". This issue is
resolved.
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Clarification of Behavior: Calyx RIM 7.0

This section provides an explanation of functionality that may be interpreted as an issue, but is in fact working as
designed. All explanations contained here will be added to the product documentation at the earliest opportunity.

Calyx RIM: Common
Issue Affected Area Description

N/A N/A After migrating to Calyx RIM 7.0, the following user
settings are reset to default for the migrated users.
— Assembly tree width
— Product Details Set tree width
— Home page side panels width and show/hide condition
— Home page widgets show/hide condition
— Columns width
— Columns order
— Columns sort order
— Columns show/hide condition
— DMS Browse window size

N/A N/A After migrating to Calyx RIM 7.0, Public or Private queries
saved in the Liquent InSight 6.2 query list will not be
available in the Calyx RIM 7.0 query list for the migrated
and newly added users.

N/A Assembly Performing any actions from Calyx RIM 7.0 CHF 1 against
a Veeva repository on limited release version 18R2.2 will
result in an exception caused by an unexpected error
response from Veeva Vault. If you experience this issue,
please contact Veeva Support.

N/A N/A If you are using network security products to scan your
local intranet hosts for vulnerabilities, be aware that these
products have a specific scan used against a JBoss server
at TCP/IP port AJP/8009. Scanning the Calyx RIM server
with a network security product will cause an outage,
requiring a restart. To avoid issues caused by network
security scanning products, see Firewall Rule for TCP_IP
Port AJP_8009 in the Calyx RIM Installation Guide.
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Issue Affected Area Description

26746 Application In D2, the application_description attribute value is a
concatenation of Application Code, and Application Name
and separated by a hyphen. The application_description
attribute value does not contain the Family Code. This is
because of the decoupling of Product Family and Product
from Application.

26740 N/A With the value for user.device.limit set to 1 in the
insight.var file, when a user is logged on to InSight on
device one, logging on to a second device terminates the
InSight session on device one. However, refreshing the
page on device one displays the InSight Home page. This
is because of the Azure SSO functionality.

26727 N/A When a user is not included in the mapping list during the
migration process, attempting to reassociate the user with
a group can cause an “Invalid Reference” error. The error
indicates the user profile is corrupted and Azure AD does
not recognize it for synchronization.

26518;
[INC0028282,
CS0199557]

N/A When using the Google Chrome or Microsoft Edge web
browsers, selecting documents in the Browse Documents
> Assign Document window sends the Browse Documents
window to the background (behind the Assembly window),
making a user activate the window for subsequent
document assignment.

26418 N/A Duplicating Browser Tabs: Prior to Calyx RIM CHF 3,
duplicating a browser tab of an active Calyx RIM session
DID NOT require login for the duplicated session created
on the new tab. From Calyx RIM CHF 3 onward,
duplicating a browser tab of an active Calyx RIM session
WILL require login for the duplicated session created on
the new tab.

24513 Assembly When searching against a Veeva repository using DMS
Search in Calyx RIM, an error may appear about exceeding
the API calls limit. By default, Veeva Vault has an API
burst limit of 2,000 API calls within a 5-minute period, and
100,000 API calls daily. These limits help to prevent
runaway script scenarios (e.g. where the logic creates an
infinite loop that continuously calls the Vault APIs). To
request an increase to this limit, please contact Veeva
Support.
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Issue Affected Area Description

22716;
[00028730]

N/A A hyphen "-" in the service account name prevents the
ability to use that service account when adding a
SharePoint repository.

Calyx RIM Publisher
Issue Affected Area Description

N/A Assembly For opening and viewing published XML files, Calyx RIM
recommends using the Microsoft Internet Explorer Web
browser. Although Calyx supports other Web browsers
(Google Chrome and Microsoft Edge), opening published
XML files is best accomplished using Internet Explorer.

N/A Assembly,
Technical
Administration

When an assembly is created from an assembly file, the
locations included in the assembly file that do not match
the repositories in Calyx RIM Technical Administration will
not be saved.

26732 Publishing
Settings library

In Internet Explorer only, the Link Inspector report page is
not refreshed when Edit Link Output Channel is
performed. The change is reflected after clicking the
Refresh button in the report. The Link Inspector report
page refreshes as expected in Microsoft Edge or Google
Chrome.
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Known Issues: Calyx RIM

The following general issues and module-specific issues were known at the time this document was published, but
(due to time limitations) could not be included in the module-specific user documentation packaged with the
software product.

Calyx RIM: Common
Issue Description

26814
(Added on Sep 28, 2021)

Using Prepare for Publishing with the Prepare Cross Reference Leafs
option selected results in the Unable to extract checksum
error if there is a reference leaf to leaf published to Documentum.

26799
(Added on Dec 23, 2022)

After you use the Bulk eCTD Import for TW submission, the Job Status
is set to Scheduled instead of Completed. This is because the tw-
regional.xml file does not contain the application code.

Workaround: Use Import eCTD to Application instead of Bulk eCTD
Import. See: Import eCTD to Application.

26807
(Added on Dec 23, 2022)

When updating a leaf in an assembly, selecting OnLoad for the Actuate
option results in an error message. This is because of the default
security settings. Workaround: Update the leaf using API.

26642 Assembly files created by exporting an assembly to the Assembly File
(XML) on versions of Calyx RIM starting with 6.2 CHF 4 cannot be
imported to Calyx RIM versions 6.2 CHF 3 and earlier.

26637
(Added on Dec 23, 2022)

In Data Administration, the Check for Date-based Notifications menu is
not available on the Notification Specifications grid.

26728 In the Global Project Plan wizard, when modifying an active ingredient
for a PDS the Withdraw Material that is already selected is not shown in
the drop-down list.

26699 Calyx RIM can incorrectly send a Native .PDF file to Calyx RIM
Rendering for extraction. Also, while a large file can fail extraction, it
might not prevent successful publishing.

Known Issues: Calyx RIM
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Calyx RIM Publisher
Issue Description

26784;
[INC0061598]

When nodes are updated in a Working view via Mass Update
Properties, the changes are not applied to the Sequence and Publishing
views. The issue occurs for both common and extended attributes of
the node.
Workaround: Use the same values for the Mass Update Properties
attributes for both Working and Publishing views.

25259;
[00052856]

When modifying Applicant Contact Values for M1 in a US 3-3 assembly,
if you Deselect a value it does not re-appear in the selection box. As a
workaround, you must save an entry with other contact values and then
edit M1 again and select the Applicant Contact Value.

25084;
[00051037, 00052759,
00056925, 00058862]

Deleting large applications or removing multiple sequences from a
lifecycle can take can take much longer than expected to produce
results.

24019 eCTD import of a US v2.3 (DTD v3.3) application containing sequences
submitted as part of a grouped submission is not supported.

20270;
[136797FW]

Links for External Bookmarks are incorrect for split documents in paper
published output.

Calyx RIM Outlook add-in
Issue Description

26757 You cannot attach the following items from an e-mail in the add-in
forms:
— Contact - .vcf
— Calendar (Event) - .ics
— Outlook e-mails - e-mails without an extension (e-mail chain, single

e-mail, and composed e-mail)

26730 When using the API GET request for retrieving the recipients from
Microsoft Graph, if the search criteria contains a space, the following
error is shown: 500 Internal Server Error

26729 In the Add Notification Recipients field, it is not possible to delete any
spaces.

26706 If more than 50 users try to submit a form, the system fails and an
error is displayed.
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Issue Description

26704 When an API request with invalid product id is sent for
CreateSubmissionAndReference, an incorrect error message is
displayed.

26639 If Calyx RIM Outlook add-in fails to submit the forms, an incorrect error
message is displayed.

26632 An auto-populate functionality does not work for the Product field in
the Calyx RIM Outlook add-in forms if the product name starts with an
article. Example: "The Product 01", "A Product 123"
In the Calyx RIM Outlook add-in forms, the auto populate does not
work for product unless more than 3 characters are typed.

26603 When using the Calyx RIM Outlook add-in desktop version on Windows
10, version 2004 and Outlook version 1908, it is not possible to click
the Export button on the Activity History Analysis page.

26598 Trying to change the Calyx RIM Outlook add-in icon takes longer time
than expected.

26587 Empty text files cannot be attached using the Browse File button.

26586 In the Calyx RIM Outlook add-in desktop version, even after restarting
the Microsoft 365 Outlook, the system fails to override the "Liquent
InSight" launch icon.

26585 When trying to attach the files for the Calyx RIM Outlook add-in forms,
ToolTips are not displayed for the following:
— Attach from email button
— Browse files button
— "No available items to attach" ToolTip when all the attachments are

already attached

Calyx RIM Rendering
Issue Description

26718 When eCTD assembly is published, the validation messages from the
backbone generator are not displayed in Job Requests Details.
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Data Administration Tables

Data Administration Tables Added: Calyx RIM 7.0

The following Data Administration tables, sections, or fields were modified with Calyx RIM 7.0.

Data Administration Section: Submission Maintenance
Data
Administration
Table Name

Entity Affected Field Name Value List Description

Submission
Maintenance >
Drug Registration
File Documents
Section

— EAEU Leaf
— Drug Registration

File Documents
Section

— Section
Code

— Section
Name

To maintain the drug registration file
documents section of the EAEU region,
the Drug Registration File Documents
Section Values table is introduced. The
values for Section Code and Section
Name can be entered in their
respective fields.

Submission
Maintenance >
Drug Registration
File Document
Values

— EAEU Leaf
— Drug Registration

File Document
Values

— Section
— Document

Code
— Name

To maintain the drug registration file
documents of the EAEU region, the
Drug Registration File Document Values
table is introduced. The values for
Section, Document Code and Name can
be entered or selected in their
respective fields.

Submission
Maintenance >
Submission
Product Type
Values

— CN 1.0 Folder
— Submission Product

Type Values

— Region
— eCTD Code
— Product

Type
— Applicable

DTD/
Schema

The Submission Product Type Values
table is added to maintain the
submission product types of the China
region. The values for Region, eCTD
Code, Product Type, and Applicable
DTD/Schema can be entered or
selected in their respective fields.
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Data Administration Fields Updated: Calyx RIM 7.0

This table describes fields that were updated with Calyx RIM 7.0.

Pick List Name Field Name Field Type 7.0 Field Size
Calyx RIM
7.0

Applicant Contact Values Applicant Contact Name Text box

Applicant Contact Type Values Applicant Contact Type Text box

Applicant ID Values Applicant Name Text box

Application Form Type Values Application Form Type Text box

Assembly Repository Variables Variable Value Text box

ATC Values ATC Description Text box

Concentration Measure Type Values Concentration Measure Type
Name

Text box

Custom List Names List Name Text box

Custom List Values List Value Text box

Device Allergenicity Values Code Name Text box

Device Nomenclature Values Code Name Text box

Device Sterility Indicator Values Code Name Text box

Device Type Values Code Name Text box

Device Usage Values Code Name Text box

Dosage/Pharmaceutical Form Values Dosage Form (Long Name) Text box

Dosage Form (Short Name) Text box

Description Text box

Drug Registration File Documents
Values

Name Text box 500

Drug Registration File Documents
Section Values

Name Text box 500

Homepage Display Properties Comments Text box

Indications/Intended Use Values Indications/Intended Use Text box

Language Values Language Name Text box

Legal Basis Values Legal Basis Name Text box
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Pick List Name Field Name Field Type 7.0 Field Size
Calyx RIM
7.0

MAH/Development Sponsor/
Organisation Values

— MAH/Development Sponsor/
Organisation Name

— Organisation Identifier
— Address
— Comments

Text box

Manufacturer Values — Manufacturer Name
— Organisation Identifier
— Address Line 1
— Comments
— Keywords
— Description

Text box

Medical Device Values Medical Device Name Text box

Medicinal Product Type Values Medicinal Product Type Name Text box

Packaging Type Values Name Text box

Procedure Type Values Procedure Type Abbreviation 100

Procedure Type Name Text box 500

Product Characteristics Values Code Name Text box

Product Family Values Family Name Text box

Product Material Values Code Name Text box

Promotional Material Doc Type Values Promotional Material Doc Type Text box

Promotional Material Type Values Promotional Material Type Text box

Promotional Material Audience Type
Values

Promotional Material Audience
Type

Text box

Qualified Person Responsible for
Pharmacovigilance (QPPV) Values

QPPV Name Text box

Quantity Unit Of Measure Values Code Name Text box

Reasons for Termination/Withdrawal
List Values

Reasons for Termination/
Withdrawal

Text box

Region Values Region Abbreviation — 100
— 200Region Name Text box
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Pick List Name Field Name Field Type 7.0 Field Size
Calyx RIM
7.0

Region Type Values Region Type Name Text box

Regulatory Activity Lead Values Regulatory Activity Lead Text box

Route of Administration Values Route of Administration (Long
Name)

Text box

RMS Values, for SPOR Maintenance
section

Term Name Text box

Short Name Text box

Secondary Event Type Values Name Text box

Sequence Description Values Sequence Description Text box

Shelf Life Type Values Code Name Text box

Special Measure Values Code Name Text box

Sterilization Requirement Values Code Name Text box

Storage Condition Values Storage Condition Text box

Sub Filing Type Values Sub Filing Type Text box

Submission Product Type Values Product Type Text box

Substances Values — Substance Name
— Molecular Formula
— CBD
— Description
— Comments

Text box

Substance Attachment Values — Attachment Name
— File Name
— Internal Name

Text box

Substance Class Values Substance Class Name Text box

Supplement Effective Date Type Values Supplement Effective Date Type
Name

Text box

Trade Name Values Trade Name Values Text box

Unit Of Presentation Values Code Name Text box

Volume Unit Of Measure Values Code Name Text box
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© Calyx™ 2022. 45 Calyx RIM Release Notes
Calyx.ai Data Administration Fields Updated:

Calyx RIM 7.0



Data Administration Tables Updated: Calyx RIM 7.0

The following Data Administration tables, sections, or fields are updated in Calyx RIM 7.0 release.

Data Administration Section: Application Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

Chief Investigator
Values

N/A N/A The Chief Investigator Values table is
hidden by default in the Data
Administration > Application
Maintenance section.

Sponsor Type Values N/A N/A The Sponsor Type Values Sponsor Type
Values table is hidden by default in the
Data Administration > Application
Maintenance section.

Application Status
Values

Application System
Process
Default Flag

When the status of an Application,
Product, Product Detail Set, Event-
Change Detail, and Sequence is
updated as a result of running a status
wizard or manually closing an event,
the status set as the System Process
Default Flag is used. Prior to this
update, the system would randomly
pick a display status to show as the
status when multiple display statuses
were set to the same internal system
status.
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Data Administration
Table Name

Entity Affected Field Name Value List Description

— Age Span Population
Values

— Application Category
Values

— Application Status
Values

— Application Type
Values

— Country Values
— CTA Product Role

Values
— Legal Status Values
— MedDRA Term

Values
— Medical Condition

Investigated Values
— Procedure Type

Values
— Reason for

Premature Ending
Values

— Region Values
— Region Type Values
— Trial Design Values
— Trial Phase Values
— Trial Scope Values
— Trial Subject Group

Values

Application — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.
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Data Administration Section: Assembly Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

Assembly Category N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Assembly DTD/Schema
Type

Assembly Status

Assembly Subcategory

Data Administration Section: Change Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

Change Type Values N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Event-Change-Detail
Status Values

Event

Event-Change-Detail
Status Values

Event System
Process
Default Flag

When the status of an Application,
Product, Product Detail Set, Event-
Change Detail, and Sequence is
updated as a result of running a status
wizard or manually closing an event,
the status set as the System Process
Default Flag is used. Prior to this
update, the system would randomly
pick a display status to show as the
status when multiple display statuses
were set to the same internal system
status.
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Data Administration Section: Custom Lists Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

Custom List Names
Values

N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Custom List Values

Data Administration Section: DMS Integration
Data Administration
Table Name

Entity Affected Field Name Value List Description

Bind to Label Values N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Bind to Status Values

Rendition Identifier
Values
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Data Administration Section: Event Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

— Action Type Values
— EU Grouping or

Worksharing Values
— Event Status Values
— Event Type Values
— PSUR Report Code

Values
— Secondary Event

Type Values
— Timeline/Event Plan

Type Values
— Timeline/Event Plan

Values

Event — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Data Administration Section: Notifications
Data Administration
Table Name

Entity Affected Field Name Value List Description

— Notification
Specifications
Values

— Notifications Values

N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.
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Data Administration Section: Other
Data Administration
Table Name

Entity Affected Field Name Value List Description

— Concentration
Measure Type
Values

— Denominator Unit
Values

— Entity XML/UI
Mappings Values

— Home Page Display
Properties Values

— Indications/
Intended Use Values

— Language Values
— Legal Basis Values
— Length Unit Of

Measure Values
— MAH/Development

Sponsor/
Organisation Values

— Master File Location
(MFL) Values

— Message Sender
Values

— Numerator Unit
Values

— Previous EV Code
Values

— Quantity Unit Of
Measure Values

— Reason for E-
Signature Values

— Reason for
Termination/
Withdrawal Values

— SME Status Values
— Sub-Indication

Values
— System Alert Type

Values
— Unit of Measure

Prefix Values
— Unit of Presentation

Values
— Weight Unit of

Measure Values

N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.
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Data Administration
Table Name

Entity Affected Field Name Value List Description

Numerator Unit Values N/A N/A The RMS Term Name field in the initial
table view now appears as a column in
the grid view.

Data Administration Section: Product Detail Set Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

Genetically Modified
Cell Origin Species
Values

N/A N/A The Genetically Modified Cell Origin
Species Values table is hidden by
default in the Data Administration >
Product Detail Set Maintenance
section.

Product Bio Type
Values

N/A N/A The Product Bio Type Values table is
hidden by default in the Data
Administration > Product Detail Set
Maintenance section.

Somatic Cell Therapy
Cell Types Values

N/A N/A The Somatic Cell Therapy Cell Types
Values table is hidden by default in the
Data Administration > Product Detail
Set Maintenance section.

Somatic Cell Therapy
Origin Species Values

N/A N/A The Somatic Cell Therapy Origin
Species Values table is hidden by
default in the Data Administration >
Product Detail Set Maintenance
section.

Somatic Cell Therapy
Origins Values

N/A N/A The Somatic Cell Therapy Origins
Values table is hidden by default in the
Data Administration > Product Detail
Set Maintenance section.

Source of Scientific
Advice Values

N/A N/A The Source of Scientific Advice Values
table is hidden by default in the Data
Administration > Product Detail Set
Maintenance section.

Type of Dossier
Submitted Values

N/A N/A The Type of Dossier Submitted Values
table is hidden by default in the Data
Administration > Product Detail Set
Maintenance section.
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Data Administration
Table Name

Entity Affected Field Name Value List Description

Type of Gene Therapy
Transfer Product Values

N/A N/A The Type of Gene Therapy Transfer
Product Values table is hidden by
default in the Data Administration >
Product Detail Set Maintenance
section.

Type of Gene Therapy
Values

N/A N/A The Type of Gene Therapy Values table
is hidden by default in the Data
Administration > Product Detail Set
Maintenance section.

Type of Genetically
Modified Cell Origin
Values

N/A N/A The Type of Genetically Modified Cell
Origin Values table is hidden by default
in the Data Administration > Product
Detail Set Maintenance section.

Product Detail Set
Maintenance

Product System
Process
Default Flag

When the status of an Application,
Product, Product Detail Set, Event-
Change Detail, and Sequence is
updated as a result of running a status
wizard or manually closing an event,
the status set as the System Process
Default Flag is used. Prior to this
update, the system would randomly
pick a display status to show as the
status when multiple display statuses
were set to the same internal system
status.
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Data Administration
Table Name

Entity Affected Field Name Value List Description

— Color Values
— Compendial

Designation/Source
Values

— Dose Frequency
Values

— Human Consumption
Product Values

— Label Type Values
— Manufacturer Values
— Manufacturing

Functions Values
— Material Type Values
— Material Values
— Medical Device Part

Code Values
— Packaging Category

Values
— Product Detail Set

Status Values
— Product Material

Values
— Production Type

Values
— QC Status Values
— Shape Values
— Shelf Life Category

Values
— Shelf Life Type

Values
— Species Values
— Storage Condition

Values
— Substance Role

Values
— Substance Type

Values
— Time Unit Values
— Volume Unit of

Measure Values

Product — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.
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Data Administration Section: Product Family Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

— ATC Values
— Division Values
— Product Family

Status Values
— Product Family

Values
— Substance Class

Values
— Substance Values
— Therapeutic Area

Values
— Therapeutic Class

Values
— Trade Name Values

N/A N/A The RMS Term Name field in the initial
table view now appears as a column in
the grid view.

Product Family — Product
Family
Status

— Product
Family
Status Date

— Developme
nt Sponsor

The Product Family Status , Product
Family Status Date , Development
Sponsor fields are hidden by default in
Data Administration > Product Family
Values section.

Product Family — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Data Administration Section: Product Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

Dosage/Pharmaceutical
Form Values

N/A N/A The RMS Term Name field in the initial
table view now appears as a column in
the grid view.

Data Administration Tables

© Calyx™ 2022. 55 Calyx RIM Release Notes
Calyx.ai Data Administration Tables Updated:

Calyx RIM 7.0



Data Administration
Table Name

Entity Affected Field Name Value List Description

Product Status Values Product System
Process
Default Flag

When the status of an Application,
Product, Product Detail Set, Event-
Change Detail, and Sequence is
updated as a result of running a status
wizard or manually closing an event,
the status set as the System Process
Default Flag is used. Prior to this
update, the system would randomly
pick a display status to show as the
status when multiple display statuses
were set to the same internal system
status.
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Data Administration
Table Name

Entity Affected Field Name Value List Description

— Applicable
Standards Values

— Conformity
Assessment Body
Values

— Conformity
Assessment Path
Values

— Country Specific
Detail Type Values

— Country Specific
Detail Values

— Device Allergenicity
Values

— Device
Nomenclature
Values

— Device Sterility
Indicator Values

— Device Type Values
— Device Usage Values
— Dosage/

Pharmaceutical
Form Values

— EC Cert Values
— Global

Harmonization Task
Force (GHTF) Class
Values

— Global Medical
Device
Nomenclature
(GMDN) Code Values

— Manufacturing
Location Values

— Medical Device
Values

— Product
Characteristics
Values

— Product Status
Values

— Product Strength
Unit Values

— Route of
Administration
Values

— Special Measure
Values

— Sterilization
Requirement Values

— Sterilization Values
— Summary of

Technical
Documentation
(STED) Values

— UMDNS Code Values

Product — Last User
Updated

— Last
Changed
Date

When the status of an Application,
Product, Product Detail Set, Event-
Change Detail, and Sequence is
updated as a result of running a status
wizard or manually closing an event,
the status set as the System Process
Default Flag is used. Prior to this
update, the system would randomly
pick a display status to show as the
status when multiple display statuses
were set to the same internal system
status.
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Data Administration Section: Project Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

— Project Status
Values

— Project Type Values

N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Data Administration Section: Publishing Requirements Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

Electronic Format
Requirement Attributes

N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Data Administration Section: Reference Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

— Reference Content
Value

— Reference
Participant Values

— Reference Status
Values

— Reference Type
Values

N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.
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Data Administration Section: Registration Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

EMA Authorisation
Status Values

N/A N/A The RMS Term Name field in the initial
table view now appears as a column in
the grid view.

— EMA Authorization
Status Values

— Medicinal Product
Type Values

— Qualified Person
Responsible for
Pharmacovigilance
(QPPV) Values

— Registration Status
Values

N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Data Administration Section: Sequence Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

Sequence Status Values Sequence System
Process
Default Flag

When the status of an Application,
Product, Product Detail Set, Event-
Change Detail, and Sequence is
updated as a result of running a status
wizard or manually closing an event,
the status set as the System Process
Default Flag is used. Prior to this
update, the system would randomly
pick a display status to show as the
status when multiple display statuses
were set to the same internal system
status.

— Filing Type Values
— Sequence Status

Values

Sequence — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.
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Data Administration Section: SPOR Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

Compendial
Designation/Source
RMS Values

N/A N/A The RMS Term Name field in the initial
table view now appears as a column in
the grid view.

Concentration Measure
Type RMS Values

Country RMS Values

Denominator Unit RMS
Values

Language RMS Values

Legal Basis RMS Values

Medical Device RMS
Values

Medicinal Product Type
RMS Values

Procedure Type RMS
Values

Route of Administration
RMS Values

Unit of Measure Prefix
RMS Values
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Data Administration
Table Name

Entity Affected Field Name Value List Description

ATC RMS Values N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Compendial
Designation/Source
RMS Values

Concentration Measure
Type RMS Values

Country RMS Values

Denominator/
Numerator Unit RMS
Values

Dosage/Pharmaceutical
Form RMS Values

EMA Authorisation
Status RMS Values

Language RMS Values

Legal Basis RMS Values

Medical Device RMS
Values

Medicinal Product Type
RMS Values

Procedure Type RMS
Values

Route of Administration
RMS Values

Unit of Measure Prefix
RMS Values

— Created By
— Created

Date

The ability to identify by whom and
when a SPOR Maintenance value was
created, either via automated updates
from the EMA or manually by Data
Administration users. By default, this
option is read-only . It is populated
automatically when updates are made
to the table.
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Data Administration Section: Submission Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

Applicant Contact Type
Values

N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Applicant Contact
Values

Applicant ID Values

Application Form Type
Values

Drug Registration File
Documents Section
Values

Drug Registration File
Document Values

Font Definition Values

Leaf Status Values

PDF Properties Values

Promotional Material
Audience Type Values

Promotional Material
Doc Type Values

Promotional Material
Type Values

Regulatory Activity
Lead Values

Submission Product
Type Values

Sequence Description
Values

Sub Filing Type Values

Supplement Effective
Date Type Values

Telephone Number
Type Values
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Data Administration Section: Submission Plan Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

Submission Plan Values N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Data Administration Section: Task Maintenance
Data Administration
Table Name

Entity Affected Field Name Value List Description

Secondary Task/Sub-
Task Type Values

N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.

Task/Sub-Task Priority
Values

Task/Sub-Task Status
Progression Values

Task/Sub-Task Status
Values

Task/Sub-Task Type
Values

Data Administration Section: Workflow Management
Data Administration
Table Name

Entity Affected Field Name Value List Description

Workflow Management
Values

N/A — Last User
Updated

— Last
Changed
Date

The ability to identify – and then export
the results to .xls - historical audit
trail data for any value in Data
Administration, including when and by
whom values were added. For SPOR
Maintenance values, the audit trail will
reflect in addition whether the values
were updated from the EMA or
manually by a Data Administration
user.
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Data Administration Tables Removed: Calyx RIM 7.0

The following Data Administration tables, sections, or fields are removed from Calyx RIM 7.0.

Data Administration Section: Contact Maintenance
Data Administration Table Name Entity

Affected
Field
Name

Value List Description

— Contact Maintenance > Contact Address/
Phone/Email Type Values

— Contact Maintenance > Contact Role Values
— Contact Maintenance > Contact Type Values
— Contact Maintenance > Recipient For Values

N/A N/A The Contact
Maintenance section is
removed.

Data Administration Section: Dossier Maintenance
Data Administration Table Name Entity

Affected
Field Name Value List Description

— Dossier Maintenance > Component Source
Type Values

— Dossier Maintenance > Discipline Values
— Dossier Maintenance > Dossier Metadata

Values

N/A N/A The Dossier Maintenance
section is removed.

Data Administration Section: Product Family Maintenance
Data Administration Table
Name

Entity
Affected

Field Name Value List Description

Product Family Maintenance
> Substance Attachment
Values

N/A N/A The Substance Attachment Values under
the Product Family Maintenance section is
removed.

Substance Values >
Attachments

N/A N/A The Attachments tab of the Substance
Values page under the Product Family
Maintenance section is removed.

Data Administration Section: Regulatory Intelligence Maintenance
Data Administration Table Name Entity Affected Field Name Value List Description

Regulatory Intelligence Maintenance >
Regulatory Intelligence Product Type
Values

N/A N/A The Regulatory Intelligence
Maintenance section is
removed.
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Entity Fields

Entity Fields and Columns Added: Calyx RIM 7.0

These tables describe fields and columns that were added in this release.

Home Page
Table 1: Tabs

Tab name Column
Name

Column Type Description Business
Rules

Product
Families

Family
Code

Read-only text
(populated
automatically)

When you open the Select Entity List
> Product Families from the left hand
navigation pane, the Family Code field
now displays as a column in the table
view.

N/A

Table 2: Search Menu

Menu Column Name Column Type Description Business
Rules

Search >
Applications

Procedure
Type

Read-only text
(populated
automatically)

The Search Results page
now includes the
Procedure Type column.

N/A

Search > Events Application
Code

Read-only text
(populated
automatically)

The Search Results page
now includes the
Application Code column.

N/A

Application
Name

Read-only text
(populated
automatically)

The Search Results page
now includes the
Application Name column.

N/A

Search >
Registrations

Application
Code

Read-only text
(populated
automatically)

The Search Results page
now includes the
Application Code column.

N/A

Application
Name

Read-only text
(populated
automatically)

The Search Results page
now includes the
Application Name column.

N/A
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Entities
Entity Name Field/Option

Name
Field Type Description Business Rules

Product Family Show in Tree Drop-down list The option Show in
Tree is added to hide
product families from
being displayed when
using the Tree Filter
functionality in the
Product Family
Attributes and Modify
Product Family pages.

You can use the
Show in Tree
option to show or
hide the product
families on the
Modify Product
Family page. By
default, this option
is set to Yes.

Package Sets Text (populated
automatically,
non-modifiable)

The Registrations tab
of the Product Family
Attributes page now
includes the Package
Sets column.

This column
displays the value
only when the
Registration Type is
Package Set. The
column will be
blank on Product
Registration Type.
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Entity Name Field/Option
Name

Field Type Description Business Rules

Event Family Type Text (populated
automatically,
non-modifiable)

The Products tab of
the Event Attributes
page now includes
the Family Type
column.

The Family Type
field value display
the Product family
Type associated
with an product.

Family Name Text (populated
automatically,
non-modifiable)

The Products tab of
the Event Attributes
page now includes
the Family Name
column.

The Family Name
field value display
the standard
product family
name recognized
internally and
across countries.
The Family Name
field value is
hyperlinked. When
selected navigates
you to the
appropriate
Product Family
Attributes page.

Family Code Text (populated
automatically,
non-modifiable)

The Products tab of
the Event Attributes
page now includes
the Family Code
column.

The Family Code
field value display
the company-
specific code for
the product family.
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Entity Name Field/Option
Name

Field Type Description Business Rules

Registrations Family Type Text (populated
automatically,
non-modifiable)

The Products tab of
the Registration
Attributes page now
includes the Family
Type column.

N/A

Family Name Text (populated
automatically,
non-modifiable)

The Products tab of
the Registration
Attributes page now
includes the Family
Name column.

The Family Name
field value is
hyperlinked. When
selected navigates
you to the
appropriate
Product Family
Attributes page.

Family Code Text (populated
automatically,
non-modifiable)

The Products tab of
the Registration
Attributes page now
includes the Family
Code column.

N/A
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Entity Name Field/Option
Name

Field Type Description Business Rules

Applications Family Type Text (populated
automatically,
non-modifiable)

The Products tab of
the Application
Attributes page now
includes the Family
Type column.

N/A

Family Name Text (populated
automatically,
non-modifiable)

The Products tab of
the Application
Attributes page now
includes the Family
Name column.

The Family Name
field value is
hyperlinked. When
selected navigates
you to the
appropriate
Product Family
Attributes page.

Family Code Text (populated
automatically,
non-modifiable)

The Products tab of
the Application
Attributes page now
includes the Family
Code column.

N/A

Associate/
Disassociate
Products

Button The Products tab of
the Application
Attributes page now
includes the
Associate/
Disassociate Products
icon.

You can associate/
dissociate more
than one product
regardless of the
Product Families to
an Application.

Application
Code

Read-only text
(populated
automatically)

The Applications grid
now includes the
Application Code
column.

N/A
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Entity Name Field/Option
Name

Field Type Description Business Rules

Indications/
Intended Use

Mass Update Action button Mass Update enables
you to update a
MedDRA version for
multiple indications/
intended entities
simultaneously.

You can use Mass
Update to enter a
MedDRA version.
You can then use
the option Update
and Overwrite to
update the new
version for all
selected
Indications or use
Update and
Preserve to update
the new version for
only those selected
Indications which
have no values.

Publishing
Settings Library

Optimize Font in
Paper Output

Drop-down list Optimize Font in
Paper Output has
been added to
Publishing Settings
Library.

Minimize font
compatibility
issues and provide
stability to the
process of printing
the paper output.
By default, the
value is No. All
assemblies
migrated from a
previous Calyx RIM
version will
have Optimize
Fonts in Paper
Output set to No.

Full Product
Presentations

XEVMPD
Submission
Required?

Drop-down list XEVMPD Submission
Required? enables
you to categorize the
Full Product
Presentations that are
ready to submit for
XEVMPD.

When you try to
create or copy Full
Product
Presentations, the
value of this field is
automatically set
to Yes. This
indicates that the
XEVMPD data is
ready for
submission.
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Wizards
Entity Name Field Name Field Type Description Business Rules

Create Application Associated
Products

Multi-select
Modifiable

The Family Name,
Family Code and
Family Type columns
are added in the
Product selection
page of the Create
Application Wizard.

N/A

Procedure Type Drop-down list The Procedure Start
Date, Procedure End
Date and Procedure
Identifier are added
to the Create
Application Wizard
and display if the
Procedure Type is
indicated as MRP, CP,
DCP, or National for
all the Application
Types except CTA or
an IND.

The fields are
included into
Create Application
> > Enter values for
new application >
Create Application.

Copy Task Application Name Read-only text
(populated
automatically)

The Copy Task >
Select Event > Select
a destination event
page now includes
the Application Name
and Application Code
columns.

This provides the
Application
uniqueness
confirmation.Application Code Read-only text

(populated
automatically)

Move Task Application Code Read-only text
(populated
automatically)

The Move Task >
Select Event > Select
a destination event
page now includes
the Application Code
column.

Global Project Plan
(all types)

Application Code Read-only text
(populated
automatically)

The Select
Applications > Select
an Application grid
now includes the
Application Code
column.

N/A

Entity Fields

© Calyx™ 2022. 71 Calyx RIM Release Notes
Calyx.ai Entity Fields and Columns Added: Calyx

RIM 7.0



Entity Name Field Name Field Type Description Business Rules

XEVMPD
Submission

Application Code Read-only text
(populated
automatically)

The XEVMPD
Submission >
Authorised Product
Search Results page
now includes the
Application Code
column.

N/A

Update Project
Event Country
Status

Application Code Read-only text
(populated
automatically)

The Select Event
Countries > Select
the event countries
you would like to
update page now
includes the
Application Code
column.

N/A

Application Name Read-only text
(populated
automatically)

The Confirmation >
Clicking Next will
peform the following
actions: page now
includes Application
Name.

N/A

Application Name Read-only text
(populated
automatically)

The Summary >
Summary page now
includes Application
Name.

N/A

Calculate Project
Dates

Application Code Read-only text
(populated
automatically)

The Select Event
Countries > Select
the event countries
you would like to
update page now
includes the
Application Code
column.

N/A

Bulk Update
Events

Application Code Read-only text
(populated
automatically)

The Select Events >
Select Events to
update page now
includes the
Application Code
column.

N/A
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Entity Name Field Name Field Type Description Business Rules

Bulk Update
Sequences

Application Code Read-only text
(populated
automatically)

The Enter Sequences
Search Criteria >
Select values to
refine search page
now includes the
Application Code
column.

N/A

Associate
Workflow to
Events or
Sequences

Application Code Read-only text
(populated
automatically)

The Associate
Workflow > Select
Events grid now
includes the
Application Code
column.

N/A

The Associate
Workflow > Select
Sequences grid now
includes the
Application Code
column.
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Entity Name Field Name Field Type Description Business Rules

Create Sequence Application Code Read-only text
(populated
automatically)

The following grids
now include the
Application Code
column:
— Project Attributes

> Create
Sequence > Select
Events grid

— Project Attributes
> Create
References for
Events > Select
Events grid

— Project Attributes
> Create
References for
Sequences >
Select Events grid

— Project Attributes
> Associate
Change Detail(s)
to Events > Select
Events grid

— Project Attributes
> Leaf Updates for
Assemblies >
Select Sequences
grid

N/A

Create References
for the Project
Events or
Sequences

Associate Change
Detail(s) to Events

Leaf Updates for
Assemblies

Create Study
Report

Update the sub-
folder structure for
5.3.5 Reports of
Efficacy and Safety
Studies

Multi-select
check box

The Update the sub-
folder structure for
5.3.5 Reports of
Efficacy and Safety
Studies option is
added to the Create
Study Reports > Enter
Properties page.

Study reports can
be added to
specific Indication
folders to improve
the data setup.

Entity Fields

© Calyx™ 2022. 74 Calyx RIM Release Notes
Calyx.ai Entity Fields and Columns Added: Calyx

RIM 7.0



Entity Name Field Name Field Type Description Business Rules

Copy Full Product
Presentation

Application Code Read-only text
(populated
automatically)

The Copy Full
Product Presentation
> Select wizard flow
> Select the flow for
the Full Product
Presentation copy
you would like to
perform > Full
Product Presentation
under different
Registration(s) page
now includes the
Application Code
column.

N/A

Copy Registration
Attachment

Application Code Read-only text
(populated
automatically)

The Copy
Registration
Attachment
Attributes > Select
Full Product
Presentation(s)
where newly copied
Registration
attachment should
be created page now
includes the
Application Code
column.

N/A
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Entity Name Field Name Field Type Description Business Rules

Import eCTD to
Application

EAEU XML with
embedded PDFs

Read-only text
(populated
automatically)

The Enter the eCTD
Folder > Choose the
eCTD Folder to
import page now
includes the EAEU
XML with embedded
PDFs option in the
Import Type drop-
down list.

EAEU XML with
embedded PDFs
has been added to
provide the
functionality
related to EAEU
regulatory
updates. You can
use EAEU XML with
embedded PDFs
while importing
EAEU submissions.
See: Calyx RIM
Best Practice: EAEU
Submissions.

EAEU XML
Location

Browse button The Enter the eCTD
Folder > Choose the
eCTD Folder to
import page now
includes the EAEU
XML Location field.

You can use EAEU
XML Location while
importing EAEU
submissions. See:
Calyx RIM Best
Practice: EAEU
Submissions.

DMS Versioning
Scheme

Radio button The Enter the eCTD
Folder > Choose the
eCTD Folder to
import page now
includes the DMS
Versioning Scheme
field.

You can use DMS
Versioning Scheme
while importing
EAEU submissions.
See: Calyx RIM
Best Practice: EAEU
Submissions.
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Entity Name Field Name Field Type Description Business Rules

Export Published
Output

Embed PDFs into
EAEU XML?

Check box The Export Published
Output page now
includes the Embed
PDFs into EAEU XML?
option.

Embed PDFs into
EAEU XML? has
been added to
provide
functionality
related to EAEU
regulatory
updates. You can
use Embed PDFs
into EAEU XML? to
export EAEU
submissions. See:
Calyx RIM Best
Practice: EAEU
Submissions.

Publishing Settings
Library

Optimize Fonts in
Paper Output

Drop-down list Publishing Settings
Library now includes
the Optimize Fonts in
Paper Output option.

Minimize font
compatibility
issues and provide
stability to the
process of printing
the paper output.
By default, the
value is No. All
assemblies
migrated from a
previous Calyx RIM
version will
have Optimize
Fonts in Paper
Output set to No.
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Entity Fields and Columns Updated: Calyx RIM 7.0

The following tables describe fields that were modified in this release.

Home Page
Table 3: Tabs

Tab name Column
Name

Column Type Description Business
Rules

Product
Families

Product
Family Type

Read-only text
(populated
automatically)

This column is renamed to Family
Type on the Product Families grid
opened from the Product Families tab
on the left pane.

N/A

Product
Family Name

Hyperlink This column is renamed to Family
Name grid from the Product Families
tab on the left pane.

Table 4: Search Menu

Menu Column
Name

Column Type Description Business
Rules

Search > Product
Families

Product
Family Name

Hyperlink This column is renamed to
Family Name on the Search
Results page.

N/A

Search > Full
Product
Presentations

Pack Set
License Code

Hyperlink This column is renamed to
License Code on the Search
Results page.

N/A

Search > Products Product
Family Name

Read-only text
(populated
automatically)

This column is renamed to
Family Name on the Search
Results page.

N/A

Search >
Components

Product
Family Name

Read-only text
(populated
automatically)

This column is renamed to
Family Name on the Search
Results page.

N/A
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Table 5: Find Menu

Menu Field
Name

Field Type Description Business
Rules

Find > Activities >
Entity Type > Product
Family

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family
Type on the View Activities List
page.

N/A

Product
Family
Name

This field is renamed to Family
Name on the View Activities List
page.

N/A

Find > Activities >
Entity Type > XEVMPD

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family
Type on the View Activities List
page.

N/A

Product
Family
Name

This field is renamed to Family
Name on the View Activities List
page.

N/A

Find > Product
Families > List of
Product Families

Product
Family
Type

Drop-down list,
Read-only text
(populated
automatically)

This field is renamed to Family
Type on the List of Product
Families page.

N/A

Product
Family
Name

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family
Name on the:
— List of Product Families page
— Display Columns multi-select

field options
— Sort Order multi-select field

options
— Search Results page
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Menu Field
Name

Field Type Description Business
Rules

Find > Applications >
List of Applications
with Product Query

Product
Family
Type

Drop-down list,
Read-only text
(populated
automatically)

This field is renamed to Family
Type on the List of Applications
with Product Query page.

N/A

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family
Name on the:
— List of Applications with

Product Query page
— Display Columns multi-select

field options
— Sort Order multi-select field

options
— Search Results page

Find > Package Set
Registrations > List of
Package Set
Registrations with
Application and
Product Detail
Properties Query

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

These fields are renamed to
Family Type and Family Name on
the:
— List of Package Set

Registrations with Application
and Product Detail Properties
Query page

— Display Columns multi-select
field options

— Sort Order multi-select field
options

— Search Results page

N/A

Product
Family
Name

Find > Product
Registrations > List of
Product Registrations
with Application and
Product Detail
Properties Query

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

These fields are renamed to
Family Type and Family Name on
the:
— List of Product Registrations

with Application and Product
Detail Properties Query page

— Display Columns multi-select
field options

— Sort Order multi-select field
options

— Search Results page

N/A

Product
Family
Name
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Menu Field
Name

Field Type Description Business
Rules

Find > Events > List of
Events with
Application Properties
Query

Product
Family
Type

Drop-down list,
Read-only text
(populated
automatically)

This field is renamed to Family
Type on the List of Events with
Application Properties Query
page.

N/A

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family
Name on the:
— List of Events with Application

Properties Query page
— Display Columns multi-select

field options
— Sort Order multi-select field

options
— Search Results page

Find > Sequences >
List of Sequences
with Application and
Event Properties
Query

Product
Family
Type

Drop-down list,
Read-only text
(populated
automatically)

This field is renamed to Family
Type on the List of Sequences
with Application and Event
Properties Query page.

N/A

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family
Name on the:
— List of Sequences with

Application and Event
Properties Query page

— Display Columns multi-select
field options

— Sort Order multi-select field
options

— Search Results page
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Entities
Entity Name Field Name Field Type Description Business Rules

Product Family
(MD, PMD)

Division Drop-down list This field is hidden by
default in the Product
Family Attributes page.

This field is not
available when
you modify
(Medical Device
and
Pharmaceutical
-Medical
Device) Product
Family.

Product Family
(FV, P, PMD, V)

ATC Last
Updated

Date The date that the ATC was
most recently updated.

N/A (attribute is
removed)

Product Family
(All)

International
Birth Date

Date This field is hidden by
default in the Product
Family Attributes page.
This field is renamed from
IBD to International Birth
Date.

This field is not
available when
you modify
(Medical
Device,
Pharmaceutical
-Medical
Device, Flu
Vaccine,
Pharmaceutical
or Veterinary)
Product Family.
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Entity Name Field Name Field Type Description Business Rules

Product Family
(All)

Product Family
Status

Drop-down list This field is hidden by
default in the Product
Family Attributes page.
This field is not available
when creating a (Medical
Device, Pharmaceutical-
Medical Device, Flu
Vaccine, Pharmaceutical or
Veterinary) Product Family.

You can create
a Product
Family (Medical
Device,
Pharmaceutical
-Medical
Device, Flu
Vaccine,
Pharmaceutical
or Veterinary)
with the
following
available
attributes:
— Product

Family Type
— Family Code
— Family Name

Product Family
Status Date

Date This field is hidden by
default in the Product
Family Attributes page.

This field is not
available when
you create any
type of (Medical
Device,
Pharmaceutical
-Medical
Device, Flu
Vaccine,
Pharmaceutical
or Veterinary)
Product Family.

Product Family
Type

Drop-down list The field is renamed to
Family Type.

Only the field
display name is
changed.

Product Family Text The field is renamed to
Family Name.

Only the field
display name is
changed.
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Entity Name Field Name Field Type Description Business Rules

Product Family
(FV, P, V, PMD)

Development
Sponsor

Drop-down list These fields are hidden by
default in the Product
Family Attributes page.

These fields are
not available
when you
modify (Medical
Device,
Pharmaceutical
-Medical
Device, Flu
Vaccine,
Pharmaceutical
or a Veterinary)
Product Family.

Approved
Trade Names

View: Display
only

PSUR Data
Lock Date

Date

PSUR Due Date Date

Therapeutic
Area

Drop-down list

Therapeutic
Classes
(Available/
Selected)

Multi-select

Generic Name Text

Product (All Types) Product Family
Type

Label The field is renamed to
Family Type.

Only the field
display name is
changed.Component

Component Active
Ingredients

Component
Reference Active
Ingredients

Pharmaceutical
Products

Modify Event-
Product

CT Shared Date
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Entity Name Field Name Field Type Description Business Rules

N/A Application
Prefix

View: Display
only

These fields are hidden for
the Standalone Assemblies
in the Publish Request
window.

Now only the
fields related to
the selected
Publishing
Output Channel
are displayed in
the Publish
Request
window.

Application
Number

Sequence
Number

Filling Type View: Display
only

These fields are displayed
only for the Sequence
Assemblies in the Publish
Request window.

Country N/A

Submittor
Name

View: Display
only

This field is renamed to
Country.

N/a

Application
Prefix

View: Display
only

These values now can be
overridden.

N/A

Application
Number

Sequence
Number

Publish eCTD/
Electronic

Include Leaf
with Status

Update Volume
Page Counts

Publishing
Output
Channel

Drop-down list Options selected in the
Publish Request window for
these fields are saved as
per the assembly and not
as per the logged in user.

N/A

Electronic
Output
Location

Browse

Paper Output
Location

Browse

Output
Document
Type

Drop-down list

Append
Application
and Sequence
Number

Checkbox

Publish eCTD/
Electronic

Radiobutton

Single File
Output
Filename

Textbox

DMS
Versioning
Scheme

Radiobutton
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Wizards
Wizard Name Field Name Field Type Description Business

Rules

Global Project
Plan (all types)

Product Family
Type

Drop-down list This field is renamed to Family
Type.

N/A

Product Family Multi-select
editable, Read-
only text
(populated
automatically)

This field is renamed to Family
Name.

N/A

Create Notification When Status
Changes to a
Specific Value

Radio button This option is hidden by default
for all the Product Family types
in the Create Notification >
Choose Notification Type step.

This option
is not
available
when you
select
Product
Family as
Entity
Type.

Product Family
Type

Drop-down list This field is renamed to Family
Type.

N/A

XEVMPD
Submission

Product Family
Name

Multi-select
editable

This field is renamed to Family
Name in the XEVMPD
Submission > Authorised
Product Selection page.

N/A
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Wizard Name Field Name Field Type Description Business
Rules

Create Submission Application
Name

Read-only text
(populated
automatically)

The Application field now shows
the value as a concatenation of
[Application Code + Application
Name] on the pages:
— Create Submission Type >

Major Update > Complete
Submission Properties

— Create Submission Type >
Amendment > Product
Family and Application
Properties

N/A

Application
Code

Drop-down list

Product Family
Type

Drop-down list This field is renamed to Family
Type on the Create Submission
Type > Amendment > Product
Family and Application
Properties page.

N/A

Product Family Drop-down list This field is renamed to Family
Name on the Create Submission
Type > Amendment > Product
Family and Application
Properties page.

N/A

Copy Event Applications Multi-select
editable

The Applications field on the
Copy Event > Choose
Applications page now shows
field value as a concatenation of
[Application Code + Application
Name]. > 

N/A

Products Multi-select
editable

This field is renamed from
Associated Products to
Products on the Copy Event >
Choose Products page.

N/A

Product Family
Type

Read-only text
(populated
automatically)

This field is renamed to Family
Type on the Copy Event >
Choose Products page.
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Entity Fields and Columns Removed: Calyx RIM 7.0

The following table describes fields and columns that are removed with Calyx RIM 7.0.

Home Page

Table 6: Tabs

Tab name Column Name Column Type Description

Product Families Therapeutic
Area

Read-only text
(populated
automatically)

These columns are removed from the
Product Families grid opened from the
Product Families tab on the left pane.Therapeutic

Class

Registrations Product Family
Type

Read-only text
(populated
automatically)

This column is removed from the
Registrations grid opened from the
Registrations tab on the left pane.

Applications Product Family Hyperlink This column is removed from the
Applications grid opened from the
Applications tab on the left pane.

Events Family Name Hyperlink This column is removed from the Events
grid opened from the Events tab on the left
pane.

Full Product
Presentations

Product Family
Name

Read-only text
(populated
automatically)

This column is removed from the Full
Product Presentations grid opened from the
Full Product Presentations tab on the left
pane.

Sequences Family Name Hyperlink This column is removed from the Sequences
grid opened from the Sequences tab on the
left pane.

Submitted Views Product Family Hyperlink This column is removed from the Submitted
Views grid opened from the Submitted
Views tab on the left pane.

Approved Views Product Family Hyperlink This column is removed from the Approved
Views grid opened from the Approved Views
tab on the left pane.

My Tasks Family Name Read-only text
(populated
automatically)

This column is removed from the My Tasks
grid opened from the My Tasks tab on the
left pane.
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Table 7: Search Menu

Menu Column Name Column Type Description

Search > Applications Family Type Read-only text (populated
automatically)

This column is removed from the
Search Results page.

Search > Events Family Type Read-only text (populated
automatically)

These columns are removed from
the Search Results page.Product

Family Name

Search > Sequences Family Type Read-only text (populated
automatically)

These columns are removed from
the Search Results page.Product

Family Name

Search >
Registrations

Family Type Read-only text (populated
automatically)

These columns are removed from
the Search Results page.Product

Family Name

Search > Full Product
Presentations

Product
Family Name

Read-only text (populated
automatically)

These columns are removed from
the Search Results page.

Entities
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Entity Name Field Name Field Type Description Business Rules

Product
Families

Therapeutic
Area

Read-only text
(populated
automatically)

The Therapeutic Area column
and value are removed from:
— Product Families grid
— Columns menu on the Product

Families grid
— Exported Excel file for the

Product Families grid

N/A (column is
removed)

Therapeutic
Classes

Read-only text
(populated
automatically)

The Therapeutic Classes column
and value are removed from:
— Product Families grid
— Columns menu on the Product

Families grid
— Exported Excel file for the

Product Families grid

N/A (column is
removed)

Create
Application

Button The Create Application button is
removed from the Applications
tab of all the types of Product
Families (Flue Vaccine,
Pharmaceutical, Medical Device,
Pharmaceutical-Medical Device,
Veterinary).

N/A (button is
removed)

Choose a field Drop-down list The values are removed from the
Choose a field drop-down menu
on the Set Filter window for the
Product Families grid:
— Product Family Status
— Product Family Status Date
— PSUR Data Lock Date
— PSUR Due Date
— Therapeutic Area

Available
options:
— IBD
— Product

Family
— Product

Family Type
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Entity Name Field Name Field Type Description Business Rules

Registrations Family Code Hyperlink This field is removed from the:
— Registrations, Create, Modify,

and View pages
— Registration-Package Set

Attributes page
— Package Set Country Attributes

page.

N/A (attribute
is removed)

Family Name Hyperlink This field is removed from the:
— Registrations, Create, Modify,

and View pages
— Registration-Package Set

Attributes page
— Package Set Country Attributes

page.

N/A (attribute
is removed)

Product Family
Type

Read-only text
(populated
automatically)

The Product Family Type column
and value are removed from:
— Registrations grid
— Columns menu on the

Registrations grid
— Exported Excel file for the

Registrations grid

The Product Family Type field is
removed from the Registrations,
Create, Modify, and View pages.

N/A (column
and attribute
are removed)
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Entity Name Field Name Field Type Description Business Rules

Applications Family Code Hyperlink This field is removed from the
pages:
— Create Application
— Modify Application
— View Application
— Applications > Countries >

Application Country Attributes
— Applications > Countries >

Add Application Countries
— Applications > Countries >

Modify Application Country
— Product Families >

Applications > Application
Attributes > Copy Application

N/A (attribute
is removed)

Family Name Hyperlink This field is removed from the
pages:
— Create Application
— Modify Application
— View Application
— Applications > Countries >

Application Country Attributes
— Applications > Countries >

Add Application Countries
— Applications > Countries >

Modify Application Country
— Product Families >

Applications > Application
Attributes > Copy Application

The Family Name value is
removed from the Choose a field
drop-down menu on the Set
Filter window for the
Applications grid.

N/A (attribute
is removed)

Associated
Products

Multi-select
editable

The Associated Products field is
removed from the Applications >
Application Attributes > Modify
Application page and is now
included in the Products tab of
the Application Attributes page.

N/A (attribute
is removed)

Product Family
Type

Read-only text
(populated
automatically)

The Product Family Type field is
removed from the pages:
— Applications > Countries >

Application Country Attributes
— Applications > Countries >

Add Application Countries
— Applications > Countries >

Modify Application Country

The Product Family Type column
is removed from:
— Registrations tab of the

Application Attributes page
— Columns menu on the

Registrations tab of the
Application Attributes page

— Exported Excel file for the
Registrations tab of the
Applications Attributes page

N/A (column
and attribute
are removed)
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Entity Name Field Name Field Type Description Business Rules

Events Product Family
Type

Label This field is removed from the
following Events pages:
— View
— Create
— Modify
— Change Details > Associate

Change Detail
— Comparators > Associate/

Disassociate Comparator to/
from Event

— Associate/Disassociate CT
Shared Data to/from Event

This field is removed from the
Associate/Disassociate CT
Shared Data to/from Event page
for EU CTA and US IND
Application types.

N/A (attributes
are removed)

Family Code Hyperlink This field is removed from the
following Events pages:
— View
— Create
— Modify
— Change Details > Associate

Change Detail
— Comparators > Associate/

Disassociate Comparator to/
from Event

— Associate/Disassociate CT
Shared Data to/from Event

This field is removed from the
Associate/Disassociate CT
Shared Data to/from Event page
for EU CTA and US IND
Application types.

N/A (attributes
are removed)

Family Name Text (populated
automatically,
Hyperlink)

The Family Name column and
value are removed from:
— Events grid
— Columns menu on the Events

grid
— Exported Excel file for the

Events grid

The Family Name field is
removed from the following
Events pages:
— View
— Create
— Modify
— Change Details > Associate

Change Detail
— Comparators > Associate/

Disassociate Comparator to/
from Event

This field is removed from the
Associate/Disassociate CT
Shared Data to/from Event page
for EU CTA and US IND
Application types.

N/A (column
attribute are
removed)

Choose a field Drop-down list These values no longer appear in
the Choose a field drop-down
menu on the Set Filter window
for the Events grid:
— Product Family
— Product Family Type

The available
options are:
— Application

Name
— Action Type
— Closed
— Association

s Closed As
— Closed Date
— Event Type
— PSUR Flag
— Reportable

in PSUR
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Entity Name Field Name Field Type Description Business Rules

Full Product
Presentations

Family Code Hyperlink This field is removed from the
Full Product Presentations View,
Create, and Modify pages.

N/A (attribute
is removed)

Family Name Hyperlink The Product Family Name
column and value are removed
from:
— Full Product Presentations

grid
— Columns menu on the Full

Product Presentations grid
— Exported Excel file for the Full

Product Presentations grid

The Family Name field is
removed from the Full Product
Presentations View, Create, and
Modify pages.

N/A (column
and attribute
are removed)

FPP Previous
EV Code

Family Code Hyperlink These fields are removed from
the FPP Previous EV Code View,
Create and Modify pages.

N/A (attributes
are removed)Family Name Hyperlink

Registration
FPP
Attachment

Family Code Hyperlink These fields are removed from
the Registration FPP Attachment
View, Create and Modify pages.

N/A (attributes
are removed)Family Name Hyperlink
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Entity Name Field Name Field Type Description Business Rules

Sequences Family Name Hyperlink The Family Name column and
value are removed from:
— Sequences grid
— Columns menu on the

Sequences grid
— Exported Excel file for the

Sequences grid

The Family Name field is
removed from the following
Sequences pages:
— Create
— Modify
— View
— Status Dates > Add Status
— Status Dates > Modify Status

N/A (column
and attribute
are removed)

Choose a field Drop-down list The Product Family value no
longer appears in the Choose a
field drop-down menu on the Set
Filter window for the Sequences
grid.

N/A

Family Code Hyperlink The Family Code field is removed
from the following Sequences
pages:
— Create
— Modify
— View
— Status Dates > Add Status
— Status Dates > Modify Status

This field is removed from the
Sequences Attributes > Tasks,
Create, Edit, and View pages.

N/A (attributes
are removed)
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Entity Name Field Name Field Type Description Business Rules

Submitted
Views

Product Family Hyperlink The Product Family column is
removed from:
— Submitted Views grid
— Columns drop-down menu on

the Submitted Views grid
— Exported Excel file for the

Submitted Views grid
— Submitted Views tab of the

Application Attributes page
— Exported Excel file for the

Submitted Views tab of the
Applications Attributes page

— Columns drop-down menu on
the Submitted Views tab of
the Application Attributes
page

N/A (column is
removed)

Approved
Views

Product Family Hyperlink The Product Family column is
removed from:
— Approved Views grid
— Columns drop-down menu on

the Approved Views grid
— Exported Excel file for the

Approved Views grid
— Approved Views tab of the

Application Attributes page
— Exported Excel file for the

Approved Views tab of the
Applications Attributes page

— Columns drop-down menu on
the Approved Views tab of the
Application Attributes page

N/A (column is
removed)
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Entity Name Field Name Field Type Description Business Rules

Tasks and Sub-
tasks

Family Code Hyperlink These fields are removed from
the Create, Edit, and View pages
of the following entities:
— Tasks > References > Tasks
— Registration Attributes >

Tasks
— Application Attributes > Tasks
— Event Attributes > Tasks
— Sequences > Tasks

N/A (attributes
is removed)Family Name

Projects Product Family Read-only text
(populated
automatically)

On the Project Attributes page,
the Product Family column and
value are removed from:
— Event Change Details tab
— Columns menu on the Event

Change Details grid
— Exported Excel file for the

Event Change Details grid

N/A (column is
removed)

Family Type Text (populated
automatically,
Hyperlink)

The Products tab of the Project
page now includes the Family
Type column

N/A

Family Name Text (populated
automatically,
Hyperlink)

The Products tab of the Project
page now includes the Family
Name column

Family Code Text (populated
automatically,
Hyperlink)

The Products tab of the Project
page now includes the Family
Code column

Changes Product Family Read-only text
(populated
automatically)

On the View Change and View
Change Detail pages, the Product
Family column and value are
removed from:
— Related Events tab
— Columns menu on the Related

Events grid
— Exported Excel file for the

Related Events grid

N/A (column is
removed)

Entity Fields

© Calyx™ 2022. 97 Calyx RIM Release Notes
Calyx.ai Entity Fields and Columns Removed:

Calyx RIM 7.0



Entity Name Field Name Field Type Description Business Rules

Product Detail
Sets

Family Name Hyperlink These fields are removed from
the Events > Product Detail Sets
> Create Product Detail Set page.

N/A (attributes
are removed)Family Code

N/A Region View: Display
only

These fields are removed from
the Publish Request window.

N/A (attributes
are removed)Family Code

Submittor
Name

Wizards
Wizard Name Field Name Field Type Description Business

Rules

Create Application Product Family
Type

Read-only text
(populated
automatically)

These fields are removed from
the Create Application > Create
Event page.

N/A
(attributes
are
removed)Family Name

Family Code

Global Project
Plan (all types)

Product Family Read-only text
(populated
automatically)

The Product Family Name
column is removed from the
Select applications > Select an
Application grid.

N/A
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Wizard Name Field Name Field Type Description Business
Rules

Update Status Family Name — Drop-down list
— Read-only text

(populated
automatically)

This field is removed from:
— Event Search Criteria >

Select values to refine search
page

— Select Event(s) > Select
Event(s) to update grid

— Enter values to update
entities page

— Update Event Country Status
page

N/A
(attributes
are
removed)

Update PSUR
Dates on the
Product
Family?

Drop-down list This field is removed from the
Enter values to update entities
page.

Product Family
Type

Read-only text
(populated
automatically)

This field is removed from the
Update Event Country Status
page.

Family Code Read-only text
(populated
automatically)

This field is removed from the
Update Event Country Status
page.

Create Submission
Plan

Product Family Read-only text
(populated
automatically)

This column is removed from
the:
— Create Submission Plan >

Select Applications page
— Create Submission Plan >

Create Event > Select
Applications page

— Create Submission Plan >
Associate Event > Select
Events page

— Create Submission Plan >
Create Sequence > Select
Events page

— Create Submission Plan >
Associate Sequence > Select
Sequence page

N/A
(column is
removed)
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Wizard Name Field Name Field Type Description Business
Rules

Create Notification Available
Options

Drop-down list The values are removed from
the Available Options drop-
down menu on the Create
Notification > Select Rule
Settings and Delivery
Destinations step for the
following Product Family types:
— Flu Vaccine:

• Product Family Status
• Product Family Status

Date
• PSUR Due Date
• PSUR Data Lock Date
• Generic Name
• Therapeutic Area
• Development Sponsor

— Medical Device:
• Product Family Status
• Product Family Status

Date
• International Birth Date
• Division

— Pharmaceutical:
• Product Family Status
• Product Family Status

Date
• PSUR Due Date
• PSUR Data Lock Date
• Generic Name
• Therapeutic Area
• Development Sponsor

— Pharmaceutical-Medical
Device:
• Product Family Status
• Product Family Status

Date
• PSUR Due Date
• PSUR Data Lock Date
• Generic Name
• Therapeutic Area
• Division
• Development Sponsor

— Veterinary:
• Product Family Status
• Product Family Status

Date
• PSUR Due Date
• PSUR Data Lock Date
• Generic Name
• Therapeutic Area
• Development Sponsor

N/A (values
are
removed)
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Wizard Name Field Name Field Type Description Business
Rules

Import Assembly
Wizard

Family Name Text This field is removed from the
Search Criteria page of the
Import Assembly Wizard for the
Sequence Assembly, Assembly
Approved View, and Assembly
Submitted View.
This column is removed from
the Matching Assemblies page
of the Import Assembly Wizard
for the Sequence Assembly,
Assembly Approved View, and
Assembly Submitted View.

N/A
(attributes
are
removed)

Display
Columns

Multi-select
editable

The Family Name option is
removed from the Display
Columns multi-select field of
the Search Criteria page in the
Import Assembly Wizard for the
Sequence Assembly, Assembly
Approved View, and Assembly
Submitted View.

Sort Order The Family Name option is
removed from the Sort Order
multi-select field of theSearch
Criteria page in the Import
Assembly Wizard for the
Sequence Assembly, Assembly
Approved View, and Assembly
Submitted View.
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Wizard Name Field Name Field Type Description Business
Rules

Update
Applications

Product Family
Status

— Multi-select
editable

— Read-only text
(populated
automatically)

These fields are removed from
the Update Applications > Enter
Applications Search Criteria >
Select values to refine search
page.
These columns are removed
from the Update Applications >
Select Applications page.

N/A
(column
and
attribute
are
removed)

ATC Code

Therapeutic
Area

Therapeutic
Class

PSUR Due Date

PSUR Data
Lock Date

Family Name Read-only text
(populated
automatically)

This column is removed from
the Update Applications >
Select Applications page.

N/A
(column is
removed)

Update Project
Event Country
Status

Product Family
Name

Read-only text
(populated
automatically)

The Product Family Name is
removed from the:
— Select Event Countries >

Select the event countries
you would like to update grid

— Confirmation > Clicking Next
will peform the following
actions: page

— Summary > Summary page

N/A
(attributes
are
removed)

Calculate Project
Dates

Product Family
Name

Read-only text
(populated
automatically)

The Product Family Name
column is removed from the
Select Event Countries > Select
the event countries you would
like to update grid.

N/A
(column is
removed)
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Wizard Name Field Name Field Type Description Business
Rules

Bulk Update
Events

Product Family — Multi-select
editable

— Read-only text
(populated
automatically)

The Product Family is removed
from the:
— Enter Events Search Criteria

> Select values to refine
search page

— Select Events > Select
Events to update grid

N/A
(attributes
are
removed)

Sort Order The Product Family value is
removed from the Sort Order
multi-select field of the Enter
Events Search Criteria > Select
values to refine search page.

Bulk Update
Sequences

Product Family — Multi-select
editable

— Read-only text
(populated
automatically)

The Product Family field is
removed from:
— Enter Sequences Search

Criteria > Select values to
refine search page

— Select Sequences > Select
Sequences to update grid

N/A
(attributes
are
removed)

Sort Order The Product Family value is
removed from the Sort Order
multi-select field of the Enter
Sequences Search Criteria >
Select values to refine search
page.

Create eCTD Family Name Read-only text
(populated
automatically)

These fields are removed from
the Create eCTD > Choose
Region page.

N/A
(attributes
are
removed)

Family Code

XEVMPD
Submission

Family Name Read-only text
(populated
automatically)

The Family Name column is
removed from the XEVMPD
Submission > Authorised
Product Search Results page.

N/A
(column is
removed)
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Wizard Name Field Name Field Type Description Business
Rules

Create Submission Family Name Drop-down list The Family Name field is
removed from the Create
Submission > Complete
Submission Properties
(application) > Complete the
submission status properties
(application) page.

N/A
(attribute is
removed)

Application
Code

Drop-down list This field is removed. Now the
Application Code value is
displayed in the Application
field as a concatenation of
[Application Code + Application
Name].

N/A
(attribute is
removed)

Product Family Read-only text
(populated
automatically)

This column is removed from
the Create Submission > Select
Events page.

N/A
(column is
removed)

Copy Event Product Family
Type

Read-only text
(populated
automatically)

These fields are removed from
the Copy Event > Choose
Products page.

N/A
(attributes
are
removed)Family Code

Family Name
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Wizard Name Field Name Field Type Description Business
Rules

Associate
Workflow to
Events or
Sequences

Product Family Read-only text
(populated
automatically)

This column is removed from
the Project Attributes >
Associate Workflow > Select
Events grid.

N/A
(columns
are
removed)

This column is removed from
the Project Attributes >
Associate Workflow > Select
Sequences grid.

Create Sequence Product Family Read-only text
(populated
automatically)

This column is removed from
the Project Attributes > Create
Sequence > Select Events grid.

Create References
for the Project
Events or
Sequences

This column is removed from
the Project Attributes > Create
References for Events > Select
Events grid.

This column is removed from
the Project Attributes > Create
References for Sequences >
Select Events grid.

Copy Registration
Attachment

Product Family
Name

Read-only text
(populated
automatically)

This column is removed from
The Copy Registration
Attachment Attributes > Select
Full Product Presentation(s)
where newly copied
Registration attachment should
be created page.

Entity Fields

© Calyx™ 2022. 105 Calyx RIM Release Notes
Calyx.ai Entity Fields and Columns Removed:

Calyx RIM 7.0



Query Fields

Query Fields and Columns Added: Calyx RIM 7.0

The following table describes fields that were added with Calyx RIM 7.0.

Registration Planning and Tracking
Query Name Field

Name
Field
Type

Description

List of Events with Change
Details

N/A N/A The Registration Planning and Tracking tab
includes the List of Events with Change Details
query.

XEVMPD Submissions - QC
Verification and Audit

N/A N/A The Registration Planning and Tracking tab
includes the XEVMPD Submissions - QC
Verification and Audit query.

XEVMPD Submissions and
Acknowledgments

N/A N/A The Registration Planning and Tracking tab
includes the XEVMPD Submissions and
Acknowledgments query.

Query Fields and Columns Updated: Calyx RIM 7.0

The following table describes fields that were updated with Calyx RIM 7.0.

Registration Planning and Tracking Queries
Query Name Field

Name
Field Type Description

List of Medical
Device Products and
Components

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on
the:
— List of Medical Device Products and

Components page
— Search Results page
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Query Name Field
Name

Field Type Description

List of Applications
with Products

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
List of Applications with Products Query
page.

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on
the:
— List of Applications with Products Query

page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

List of Events with
Application
Properties

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
List of Events with Application Properties
Query page.

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on
the:
— List of Events with Application Properties

Query page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Event Change Detail
Report

N/A N/A This report is renamed to List of Events with
Change Details .

List of Events with
Change Details

Product
Family
Type

Drop-down list,
Read-only text
(populated
automatically)

This field is renamed to Family Type on the
List of Events with Change Details page.

Product
Family
Name

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on
the:
— List of Events with Change Details page.
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page
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Query Name Field
Name

Field Type Description

List of Sequences
with Application and
Event Properties

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
List of Sequences with Application and Event
Properties Query page.

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on
the:
— List of Sequences with Application and

Event Properties page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

List of Registrations
with Application
Properties

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the:
— List of Registrations with Application

Properties Query
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family
Name

This field is renamed to Family Name on
the:
— List of Registrations with Application

Properties Query
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

PSUR World Wide
Marketing
Authorization Status
Query

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the
PSUR World Wide Marketing Authorization
Status Query page.

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on the
PSUR World Wide Marketing Authorization
Status Query page.
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Query Name Field
Name

Field Type Description

List of References -
Rollup by Application

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
List of References - Rollup by Application
Query page.

Product
Family

This field is renamed to Family Name on the
List of References - Rollup by Application
Query page.

List of References -
Rollup by Product
Family

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
List of References - Rollup by Product Family
Query page.

Product
Family

This field is renamed to Family Name on the
List of References - Rollup by Product Family
Query page.

List of Tasks - Rollup
by Product Family

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
on the List of Tasks - Rollup by Product
Family page.

Product
Family

This field is renamed to Family Name on the
List of Tasks - Rollup by Product Family
page.

List of Tasks - Rollup
by Application

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
List of Tasks - Rollup by Application page.

Product
Family

This field is renamed to Family Name on the
List of Tasks - Rollup by Application page.

List of CTA
Applications

Product
Family
Type

Drop-down list,
Read-only text
(populated
automatically)

This field is renamed to Family Type on the:
— List of CTA Applications page.
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

This field is renamed to Family Name on
the:
— List of CTA Applications page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page
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Query Name Field
Name

Field Type Description

List of IND
Applications

Product
Family
Type

Drop-down list,
Read-only text
(populated
automatically)

This field is renamed to Family Type on the:
— List of IND Applications page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

This field is renamed to Family Name on
the:
— List of IND Applications page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

List of Products with
Event and Product
Registration Details

Product
Family
Type

Drop-down list,
Read-only text
(populated
automatically)

This field is renamed to Family Type on the:
— List of Products with Event and Product

Registration Details page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

Multi-select editable This field is renamed to Family Type on the
List of Products with Event and Product
Registration Details page.

Applications Sent,
Submitted, or
Approved - Searched
by INN or Active
Ingredient

Product
Family
Name

Read-only text
(populated
automatically)

This field is renamed to Family Name on
the:
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page
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Query Name Field
Name

Field Type Description

Applications
Submitted and/or
Approved and/or
Terminated within a
Date Range

Product
Family
Name

Read-only text
(populated
automatically)

This field is renamed to Family Name on
the:
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product Detail Management Queries
Query Name Field

Name
Field Type Description

List of Application
Countries with PDS
Country and
Registration Details

Product
Family
Type

Drop-down list,
Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the:
— List of Application Countries with PDS

Country and Registration Details page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family
Name

This field is renamed to Family Name on
the:
— List of Application Countries with PDS

Country and Registration Details page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

List of CTA
Applications with PDS
Details

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
List of CTA Applications with PDS Details
page.

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on
the:
— List of CTA Applications with PDS Details

page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page
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Query Name Field
Name

Field Type Description

List of Product Detail
Sets

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the
List of Product Detail Sets Query page.

Product
Family

This field is renamed to Family Name on
the:
— List of Product Detail Sets Query page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

List of Registration
Package Sets
Withdrawn

Product
Family
Type

Drop-down list This field is renamed to Family Type on the:
— List of Registration Package Sets

Withdrawn page
— Search Results page

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on
the:
— List of Registration Package Sets

Withdrawn page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Application History
Query

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
Application History Query page.

Product
Family

This field is renamed to Family Name on
the Application History Query page.

Application QC Status
History Report

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
Application QC Status History Report page.

Product
Family

This field is renamed to Family Name on
the Application QC Status History Report
page.
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Query Name Field
Name

Field Type Description

Sunset Clause
Marketing Status
Query

Product
Family
Type

Drop-down list This field is renamed to Family Type on the:
— Sunset Clause Marketing Status Query

page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

Drop-down list This field is renamed to Family Type on the:
— Sunset Clause Marketing Status Query

page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

List of Active
Ingredient
Manufacturers

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the:
— List of Active Ingredient Manufacturers

page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

This field is renamed to Family Name on
the:
— List of Active Ingredient Manufacturers

page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page
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Query Name Field
Name

Field Type Description

List of Active
Ingredient Function
Manufacturers

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the:
— List of Active Ingredient Function

Manufacturers page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

This field is renamed to Family Name on
the:
— List of Active Ingredient Function

Manufacturers page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

List of Active
Ingredient Material
Manufacturers

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the:
— List of Active Ingredient Material

Manufacturers page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

This field is renamed to Family Name on
the:
— List of Active Ingredient Material

Manufacturers page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Query Fields
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Query Name Field
Name

Field Type Description

List of Excipient
Manufacturers

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the:
— List of Excipient Manufacturers page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

This field is renamed to Family Name on
the:
— List of Excipient Manufacturers page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

List of PDS
Manufacturers

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the:
— List of PDS Manufacturers page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

This field is renamed to Family Name on
the:
— List of PDS Manufacturers page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Query Fields
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Query Name Field
Name

Field Type Description

List of Component
Manufacturers

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the:
— List of Component Manufacturers page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

This field is renamed to Family Name on
the:
— List of Component Manufacturers page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

List of Package Set
Manufacturers

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the:
— List of Package Set Manufacturers page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

This field is renamed to Family Name on
the:
— List of Package Set Manufacturers page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

List of Species and
Indications

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on
the:
— List of Species and Indications page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Query Fields
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Query Name Field
Name

Field Type Description

List of Dose Schedules Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on
the:
— List of Dose Schedules page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

List of Withdrawal
Times

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on
the:
— List of Withdrawal Times page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Labeled Indications
Query

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the:
— Labeled Indications Query page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

This field is renamed to Family Name on
the:
— Labeled Indications Query page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Query Fields
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Query Name Field
Name

Field Type Description

List of IND
Applications with PDS
Details

Product
Family
Type

Drop-down list,
Read-only text
(populated
automatically)

This field is renamed to Family Type on the:
— List of IND Applications with PDS Details

page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on
the:
— List of IND Applications with PDS Details

page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

— List of Product
Registrations with
Application and
Product Detail
Properties

— List of Registrations
with Indications/
Intended Use

— List of Registrations
with Excipients

— List of Registrations
with Active
Ingredients

— List of Registrations
with Material

— List of Registrations
with Labeling

— List of Registrations
with Packaging

— List of Registrations
with Local Country
Details

Product
Family
Type

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Type on the:
— Queries
— Display Columns multi-select field

options of the queries.
— Sort Order multi-select field options of

the queries
— Search Results page of the queries

Product
Family
Name

This field is renamed to Family Name on
the:
— Queries
— Display Columns multi-select field

options of the queries
— Sort Order multi-select field options of

the queries
— Search Results page of the queries.

Query Fields
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Query Name Field
Name

Field Type Description

List of Application
Countries with PDS
Country and
Registration Details

Product
Family
Type

Drop-down list,
Read-only text
(populated
automatically)

This field is renamed to Family Type on the:
— List of Application Countries with PDS

Country and Registration Details page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family
Name

Drop-down list,
Read-only text
(populated
automatically)

This field is renamed to Family Name on
the:
— List of Application Countries with PDS

Country and Registration Details page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Product
Family
Code

Read-only text
(populated
automatically)

This field is renamed to Family Code on the:
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Submission Planning and Tracking Queries
Query Name Field Name Field Type Description

List of Events with
Application
Properties

Product
Family
Type

Drop-down This field is renamed to Family Type on the
List of Events with Application Properties
Query page.

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on:
— List of Events with Application Properties

Query page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Query Fields
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Query Name Field Name Field Type Description

List of Sequences
with Application and
Event Properties

Product
Family
Type

Drop-down This field is renamed to Family Type on the
List of Sequences with Application and Event
Properties Query page.

Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on:
— List of Sequences with Application and

Event Properties Query page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

List of Applications Product
Family

Multi-select
editable, Read-only
text (populated
automatically)

This field is renamed to Family Name on:
— List of Applications Query page
— Display Columns multi-select field

options
— Search Results page

List of References -
Rollup by
Application

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
List of References - Rollup by Application
Query page.

Product
Family

This field is renamed to Family Name on the
List of References - Rollup by Application
Query page.

List of References -
Rollup by Product
Family

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
List of References - Rollup by Product Family
Query page.

Product
Family

This field is renamed to Family Name on the
List of References - Rollup by Product Family
Query page.

Registered Document Analysis Queries
Query Name Field Name Field Type Description

Registered
Document Query

Product
Family

Multi-select editable,
Read-only text
(populated
automatically)

This field is renamed to Family Name on the:
— Registered Document Query page
— Display Columns multi-select field

options
— Sort Order multi-select field options
— Search Results page

Query Fields
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Query Name Field Name Field Type Description

List of Events with
Application
Properties

Product
Family
Type

Drop-down This field is renamed to Family Type on the
List of Events with Application Properties
Query page.

Product
Family

Multi-select editable,
Read-only text
(populated
automatically)

This field is renamed to Family Name on:
— List of Events with Application Properties

Query page
— Display Columns multi-select field

options
— Sort Order multi-select field options.
— Search Results page

List of Applications Product
Family

Multi-select editable,
Read-only text
(populated
automatically)

This field is renamed to Family Name on:
— List of Applications Query page.
— Display Columns multi-select field

options
— Search Results page.

List of Tasks -
Rollup by
Application

Product
Family
Type

Drop-down list This field is renamed to Family Type on the
List of Tasks - Rollup by Application page.

Product
Family

This field is renamed to Family Name on the
List of Tasks - Rollup by Application page.

Query Fields
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Query Fields and Columns Removed: Calyx RIM 7.0

The following table describes fields that were removed with Calyx RIM 7.0.

Query Fields
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Registration Planning and Tracking Queries
Query Name Field Name Column Name Field Type Description

List of Application
Countries with
Registration
Details

Product Family
Status

N/A Multi-select
editable

This field is
removed from the
List of Application
Countries with
Registration
Details Query.

Display Columns N/A Multi-select
editable

The following
options are
removed from the
Display Columns
multi-select field
of the List of
Application
Countries with
Registration
Details Query:
— Product Family

Status
— Product Family

Status Date
— Therapeutic

Area
— Therapeutic

Class

Sort Order N/A Multi-select
editable

The following
options are
removed from the
Sort Order multi-
select field of the
List of Application
Countries with
Registration
Details Query:
— Product Family

Status (ASC,
DESC)

— Product Family
Status Date
(ASC, DESC)

— Therapeutic
Area (ASC,
DESC)

— Therapeutic
Class (ASC,
DESC)

Query Fields
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Query Name Field Name Column Name Field Type Description

List of Application
with Products

— Therapeutic
Area

— Therapeutic
Class

— Product Family
Status

— PSUR Due
Date

— PSUR Data
Lock Date

N/A Multi-select
editable

These fields are
removed from the
List of Application
with Products
Query.

— Therapeutic Area
— Therapeutic Class
— Product Family

Status
— PSUR Due Date
— PSUR Data Lock Date

These columns
are removed from
the Search
Results page.

Query Fields
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Query Name Field Name Column Name Field Type Description

List of Product
Families

Product Family
Status

N/A Multi-select
editable

These fields are
removed from the
List of Product
Families query.Therapeutic Area

Therapeutic Class

Development
Sponsor

Product Family
Status Date

Date

Next PSUR Date

PSUR Data Lock
Date

Generic Name Text

N/A — Product Family
Status

— Product Family
Status Date

— Next PSUR Date
— PSUR Data Lock Date
— Generic Name
— Area
— Class
— Development

Sponsor

Read-only text
(populated
automatically)

These columns
are removed from
the Search
Results page of
the List of
Product Families
query.

List of
Pharmaceutical
Products

Therapeutic
Classes

N/A Multi-select
editable

This field is
removed from the
List of
Pharmaceutical
Products query.

N/A — Family Status
— Family Status Date
— Classes

Read-only text
(populated
automatically)

These columns
are removed from
the Search
Results page of
the List of
Pharmaceutical
Products query.

Query Fields
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Query Name Field Name Column Name Field Type Description

List of Veterinary
Products

Therapeutic
Classes

N/A Multi-select
editable

This field is
removed from the
List of Veterinary
Products.

N/A — Family Status
— Family Status Date
— Classes

Read-only text
(populated
automatically)

These columns
are removed from
the Search
Results page of
the List of
Veterinary
Products query.

List of Medical
Device Products

N/A — Family Status
— Family Status Date

Read-only text
(populated
automatically)

These columns
are removed from
the List of Medical
Device Products.

List of
Pharmaceutical
and Medical
Device Products

Therapeutic
Classes

N/A Multi-select
editable

This field is
removed from the
List of
Pharmaceutical
and Medical
Device Products

N/A — Family Status
— Family Status Date
— Classes

Read-only text
(populated
automatically)

These columns
are removed from
the Search
Results page of
the List of
Pharmaceutical
and Medical
Device Products
query.

Query Fields
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Query Name Field Name Column Name Field Type Description

List of
Pharmaceutical
Products and
Components

Therapeutic
Classes

N/A Multi-select
editable

This field is
removed from the
List of
Pharmaceutical
Products and
Components.

N/A — Product Family
Status

— Product Family
Status Date

— Therapeutic Classes

Read-only text
(populated
automatically)

These columns
are removed from
the Search
Results page of
the List of
Pharmaceutical
Products and
Components
query.

List of Medical
Device Products
and Components

N/A — Product Family
Status

— Product Family
Status Date

Read-only text
(populated
automatically)

These columns
are removed from
the List of
Medical Device
Products and
Components
query page.

List of Veterinary
Products and
Components

Therapeutic
Classes

N/A Multi-select
editable

This field is
removed from the
List of Veterinary
Products and
Components
query page.

— Product Family
Status

— Product Family
Status Date

— Therapeutic Classes

Read-only text
(populated
automatically)

These columns
are removed from
the Search
Results page of
the List of
Veterinary
Products and
Components
query.

Query Fields
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Query Name Field Name Column Name Field Type Description

List of
Pharmaceutical
and Medical
Device Products
and Components

Therapeutic
Classes

N/A Multi-select
editable

This field is
removed from the
List of
Pharmaceutical
and Medical
Device Products
and Components
page.

N/A — Product Family
Status

— Product Family
Status Date

— Therapeutic Classes

Read-only text
(populated
automatically)

These columns
are removed from
the Search
Results page of
the List of
Pharmaceutical
and Medical
Device Products
and Components
query.

Query Fields
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Query Name Field Name Column Name Field Type Description

List of
Registrations with
Application
Properties

PSUR Data Lock
Date

N/A Date This field is
removed from the
List of
Registrations with
Application
Properties Query.

PSUR Due Date This field/value is
removed from:
— List of

Registrations
with
Application
Properties
Query

— Display
Columns
multi-select
field options

— Sort Order
multi-select
field options

N/A PSUR Due Date This column is
removed from the
Search Results
page.

Query Fields
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Query Name Field Name Column Name Field Type Description

— List of
Registrations
for a Product
Family

— List of
References -
Rollup by
Product Family

— List of Tasks -
Rollup by
Product Family

Division N/A Multi-select
editable

This field/value is
removed from:
— Queries
— Display

Columns
multi-select
field options of
the queries

— Sort Order
multi-select
field options of
the queries

N/A Division Read-only text
(populated
automatically)

This column is
removed from the
Search Results
page of these
queries.

Query Fields

© Calyx™ 2022. 130 Calyx RIM Release Notes
Calyx.ai Query Fields and Columns Removed:

Calyx RIM 7.0



Product Detail Management Queries
Query Name Field Name Column Name Field Type Description

— List of
Registrations
with
Application
Properties
Query

— List of Product
Registrations
with
Application
and Product
Detail
Properties

— List of
Registrations
with
Indications/
Intended Use

— List of
Registrations
with Excipients

— List of
Registrations
with Active
Ingredients

— List of
Registrations
with Material

— List of
Registrations
with Labeling

— List of
Registrations
with Packaging

— List of
Registrations
with Local
Country
Details

PSUR Data Lock
Date

N/A Date This field is
removed.

PSUR Due Date This field/value is
removed from:
— Queries
— Display

Columns
multi-select
field options of
the queries

— Sort Order
multi-select
field options of
the queries

N/A PSUR Due Date This column is
removed from the
Search Results
page of these
queries.

Query Fields
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Query Name Field Name Column Name Field Type Description

List of Application
Countries with
PDS Country and
Registration
Details

N/A Product Family Status Read-only text
(populated
automatically)

These columns
are removed from
the Search
Results page.

N/A Product Family Status
Date

Sort Order The following
values are
removed from the
Sort Order multi-
select field:
— Product Family

Status
— Product Family

Status Date

Query Fields
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Submission Planning and Tracking
Query Name Field Name Column Name Field Type Description

List of
Applications

Product Family
Status

N/A Multi-select
editable, Read-
only text
(populated
automatically)

These fields are
removed from:
— List of

Applications
Query

— Display
Columns
multi-select
field options

PSUR Due Date Date

PSUR Data Lock
Date

N/A Product Family Status Read-only text
(populated
automatically)

These columns
are removed from
the Search
Results page of
the List of
Applications
query.

PSUR Due Date

PSUR Data Lock Date

Sort Order Multi-select
editable

The following
options are
removed from the
Sort Order multi-
select field of the
List of Application
Query:
— Product Family

Status (ASC,
DESC)

— Product Family
Status Date
(ASC, DESC)

— Therapeutic
Area (ASC,
DESC)

— Therapeutic
Class (ASC,
DESC)

Query Fields
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Registered Document Analysis
Query Name Field Name Column Name Field Type Description

List of
Applications

Product Family
Status

N/A Multi-select
editable, Read-
only text
(populated
automatically)

These fields are
removed from:
— List of

Applications
Query

— Display
Columns
multi-select
field options

PSUR Due Date Date

PSUR Data Lock
Date

Product Family Status Read-only text
(populated
automatically)

These columns
are removed from
the Search
Results page of
the List of
Applications
query.

PSUR Due Date

PSUR Data Lock Date

Sort Order N/A Multi-select
editable

The following
options are
removed from the
Sort Order multi-
select field of the
List of Application
Query:
— Product Family

Status (ASC,
DESC)

— Product Family
Status Date
(ASC, DESC)

— Therapeutic
Area (ASC,
DESC)

— Therapeutic
Class (ASC,
DESC)

Query Fields
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Database Columns Changed: Calyx RIM 7.0

The following Database Columns were added, modified, or removed in this release.

Field Name Field Size Database Column
Name

Db Column Size Db Table Name

Application Name N/A NAME VARCHAR2(500) is changed to
VARCHAR2(2000).

APPLICATION

Database Columns Changed: Calyx RIM 7.0

© Calyx™ 2022. 135 Calyx RIM Release Notes
Calyx.ai Query Fields and Columns Removed:

Calyx RIM 7.0



Access the Customer Service Portal

If you have issues when working in the system that you cannot resolve with the Help documentation, you can access
the Service Portal to view knowledge articles or log a support ticket.

To access the Service Portal:
1. Navigate to mytrials.com.

The Perceptive MyTrials log in page appears.
2. Enter your Perceptive MyTrials user name and password, and click Log On.

If you do not have a Perceptive MyTrials account, click Join Perceptive MyTrials and register. Perceptive
MyTrials confirms your account with an email.
The home page appears.

3. Do one of the following:
— Click Customer Care at the bottom of the page.
— In the My Weblinks portlet, click Customer Service Portal.

The home page for the Service Portal appears. You can browse and search for the information you need.

Access the Customer Service Portal
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